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ENGLISH SUMMARY

In the last years, the growing of the Systems on Chip (SoC) has shown a problem with the
interconnection with buses. It becomes a bottleneck due to the poor scalability of the
buses. Because of that a new way of interconnection, Network-on-chip (NoC), has been
developed. NoCs uses the idea of the computer network to implement a similar solution to
make the interconnections in SoCs.

Unfortunately, NoC development is a hard task. In the last times have been developed
some tools, such as SunFloor or XpipesCompiler that brings a great help to the NoC
designer. But these applications only generate and compile topologies, and it was such a
hard task. With NoCdificador we try to develop a tool that helps the NoC designer to
modify his NoCs in a completely safe way.

But NoCdificador is not only a NoC modifier. It also controls the correctness of the network,
can generate new networks from the beginning, can create or edit SunFloor input files
and then invoke SunFloor. With NoCdificador, a ftopology can be simulated with
XpipesCompiler and simulated with MPARM. And one of the most attractive features of
this tool is the different statistics shown for the same network: simulated with AMBA (bus
inferconnection) and Xpipes (NoC interconnection), and even a graphic comparative
between both simulations.

Our application has been developed in Java. One of the requirements of the program
was that it had to be multiplatform, so we chose the multiplatform language we knew the
best.



RESUMEN EN CASTELLANO

Nuestro proyectro consiste en la creacion de una herramienta de generacion de
arquitecturas de interconexionado para una plataforma de emulacién multiprocesador
sobre FPGA.

1. Marco de trabajo

Comenzaremos orientando al lector sobre el marco en que se desarrolla nuestro frabajo y
que objetivos persigue.

Actualmente los sistemas en chip (SoC) son cada vez mds complejos, por la gran
cantidad de componentes predisenados que lo conforman.

Necesitamos que los diferentes componentes del SoC puedan enviarse informacion. La
alternativa, llamémosla mdas “cldasica”, consistia en que los procesadores y los dispositivos
de memoria se comunicaran mediante buses. Pero, a medida que el tamano de los SoC
crece, esta via sufre problemas de escalabilidad de los buses, ademds de una longitud
cada vez mayor de las conexiones.

Cobra pues sentido buscar una alternativa de futuro para la comunicacion de los SoC.
Las redes en chip, NoC, representan una variante fiable de interconexion, extrapolando
algunos de los conceptos de las redes de computadores a la interconexion de multiples

IP-Cores difundidos sobre un sustrato comun.

Actualmente existen varias lineas de investigacion frabajando sobre el diseno de NoC,
tarea para nada sencilla.

Es en este punto donde cobra sentido nuestro proyecto, como soporte grdfico que dé un
aspecto visual mdas amigable al arduo trabajo de elegir que diseno de red confeccionar,

como estructurar esta red, y como observar de un plumazo algunos de los resultados
obtenidos al simular de esta red.

2. Especificacion “a vista de pdjaro” de la funcionalidad que ofrece nuestra herramienta

- Construir una aplicacion que sea capaz de implementar la siguiente funcionalidad:
I. Definir una red con todos sus componentes, partiendo de cero:
(Elementos interesados en comunicarse)

Procesadores
Dispositivos de memoria



(Construccion de vias de comunicacion)
Eleccién de una topologia de las estructuras de
inferconexion
Switches de inferconexion
Links que definan los posibles caminos que puedan llevar los
datos

(Comunicaciones establecidas)
Rutas que comuniquen proporcionando un sencillo entorno
grdfico para la construccion de la red, asi como la posibilidad de
visualizarla en fodo momento de su construccion.

Abrir una red ya existente y modificarla.

Mantener en todo momento un “conocimiento de la validez

estructural de nuestra red”, permitiendo al investigador modificar a su antojo los
diferentes elementos de esta con la tranquilidad de poder ser informado cuando
lo desee de situaciones que hagan la red inestable.

Interaccionar con el Programa Sunfloor, que entre su diversa funcionalidad se
encuentra el, conociendo aspectos técnicos como:

a. Las aplicaciones que queremos tenga nuestra red.
b. La tecnologia de las interconexiones de nuestra red.
c. Las caracteristicas de los IP.

Confeccionar una red y un floorplan, o diseno interno del chip que contendrd a
nuestra red.

3a) Dadas unas especificaciones a.b.c. Sunfloor generard su salida, y nuestra
aplicaciéon serd capaz de utilizar la red proporcionada como salida por SunFloor y
abrirla, para poder trabajar con ella, asi como mostrar el FloorPlan.

3b) Proporcionar al investigador la posibilidad de definir él mismo los aspectos
técnicos de una red a construir dentro de nuestro propio programa, a fravés de un
interfaz grafico sencillo y amigable. Después podrd llamar desde nuestro programa
a SunFloor y trabajar con la red obtenida.

Interaccionar con el programa XpipesCompiler, que entre su diversa funcionalidad
es capaz de, tomando una red vdlida de entrada, compilarla a cédigo SystemC.
Ese mismo cédigo SystemC, mediante MPARM es capaz de simular la red y ofrecer
unos resultados sobre su rendimiento.

Nuestra aplicacion serd capaz de comprobar si la red que le enviamos a
XpipesCompiler es vdlida, asi como mostrar en un entorno grdfico los resultados de
rendimiento obtenidos.



3. Especificacion “con todo detalle” de la funcionalidad de nuestra aplicacién

Nuestro sistema permitird al usuario trabajar Unicamente con una red en cada momento,
si el usuario quiere abrir ofra red serd preciso que cierre previamente la red con la que
estaba frabajando.

Lo que si se permitird serd lanzar varias instancias de nuestra aplicacion, para poder tratar
con varias redes a la vez, cada una dentro de una ventana.

Nuestra aplicacion permite al usuario elegir entre las distintas funciones que puede
aplicar, navegando entre las distintas enfradas de la barra de menu, o pulsando sobre los
iconos de la barra de herramientas.

Los menuUs con los que puede interaccionar el usuario son:

a)

b)

f)

g

h)

File & Nueva red, abrir una ya existente, cerrar la red en uso, salvar, salvar como,
salir de la aplicacion

Edit > Deshacer, rehacer

View 2 Log, componentes incompletos de la red, pardmetros de la red resultado
de aplicar SunFloor.

Components - Crear, modificar y eliminar un componente

Simulate = Simular una ruta, simular la red, compilar la red, ver el cédigo HDL
resultante de nuestra red

Network =2 Tipo de red, cambiar su nombre

SunFloor - Cargar archivos para paso de pardmetros, mostrar el floorplan, indicar
las preferencias de visualizacion de las tablas

Graph = Mostrar y ocultar el grafo de nuestra red

Stats &> Ver las estadisticas de rendimiento de nuestra red, segun AMBA, segun
Xpipes, y mostrar una comparativa entre ellas

Help - Manual de usuario, “Acerca de” de la aplicacion

Los iconos de la barra de herramientas son:

a)
b)
c)
d)
e)
f)

g
h)

Open

Save

New File

Help

Undo

Redo

Simulate network
Simulate route



i) New Component

j) Modify Component
k) Delete Component
) View Log

m) Show Graph

n) Close Graph

Como interfaz grdfica, se compone de dos paneles fundamentales, uno a la izquierda
que permite visualizar un arbol con los componentes de la red, y ahondar un poco mas
en los pardmetros que conforman la composicidon de nuestra red, si ésta es fruto del
trabajo de SunFloor.

A la derecha un panel de mayor tamano, donde visualizar la informacién mds inmediata
que quiera consultar el usuario sobre la red.

3.1. Definir una red “partiendo de cero”

Nuestro sistema esta preparado para soportar tres tipos de topologias de red, que son
Mesh o Torus, dentro de las topologias regulares, u Others, como calificativo que engloba
a las topologias irregulares.

Si se escoge una red de topologia regular el sistema crea automdaticamente los switches
que serviran de inferconexion, asi como los links que comuniquen a estos.

Si se escoge una topologia regular el sistema partird de una red vacia, sobre la que se
podrdn comenzar a colocar los Procesadores y Dispositivos de memoria, asi como los
propios elementos de interconexion.

Es en esta construccion de la red donde se puede ver la importancia de esta
herramienta NoCDificador, ya que su no existencia supondria necesitar un conocimiento
profundo de los archivos que definen a las redes, de los atributos de cada elemento, de
su orden, de las restricciones de interconexion.

Esto convertiria el diseno de las redes, en un trabajo oscuro, donde cada pequeno paso
de diseno, cada pequena alternativa de decision a tomar se traduciria en una tarea muy
compleja y oscura.

Con esta aplicacion, el usuario ird construyendo su red a través de cuadros de dialogo
sencillos y amigables, con un sistema que, por un lado, le permita definir y conectar los
componentes a su antfojo, y por ofro le guarde bien las espaldas, garantizandole la
validez estructural de su trabagjo.

Nuestro sistema, en su aspiracion de ir dirigido al trabajo de investigadores, distinguird
entre errores criticos y subsanables, no permitiendo los primeros por no tener sentido y
adyvirtiendo de los segundos, para alertar al tfrabajador de los “efectos colaterales” que
pueden estar suponiendo sus decisiones sobre un cierto componente determinado.

Este representa otro objetivo fundamental de nuestro trabagjo, el garantizar una
“constante visidon de la consistencia de nuestra red”. Asi, cualquier pequeno cambio que
el usuario haga sobre un determinado componente, serd controlado, en el sentido de
modificar todos los componentes que se vean afectados por este cambio.

Veamos por ejemplo, que si nuestro usuario elimina un switch, automdticamente nuestra
aplicacion modifica todos los componentes core que se encontrardn conectados a ese
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switch, todos los link que conectardn ese switch y todas las rutas que en su
encaminamiento se encontrardn con ese switch.

De nuevo otra ventaja para el disenador con respecto a enfrentarse directamente con
un archivo de texto que defina la red.

Otra funcionalidad que ofrece la aplicaciéon es la posibilidad de deshacer y rehacer los
Ultimos cambios efectuados sobre la red que se estd tratando.

Uno puede por ejemplo, imaginar, desde el punto de vista de diseno, que supone el
plantearse una alternativa, por ejemplo, cambiar un determinado core, conectandolo a
otro switch diferente del que se encuentra en este momento. Con solo un par de clicks,
nuestro usuario puede efectuar el cambio, puede visualizar su nueva red, puede ser
informado de "los famosos efectos colaterales” que este cambio produciria, y puede
deshacer la modificacion del Core (y todos los cambios colaterales que ello supone).
Facil, amigable, y rapido.

Pero no perdamos de vista o que supone una red en chip, desde el punto de vista casi
de definicibn como sistema que comunique los procesadores con los dispositivos de
memoria y viceversa.

Nuestra aplicacion ofrece un modo sencillo de visualizar todas las rutas de comunicacion
definidas en nuestra red asi como todos y cada uno de los puntos por los que pasan.

Y si una imagen vale mds que mil palabras, nuestra aplicaciéon también permite visualizar
en todo momento de un modo grdfico el aspecto de nuestra red, permitiendo observar
uno a uno los cambios realizados, y haciendo que el usuario pueda acceder
rdpidamente a los componentes con un par de clicks en el grafico sobre aquel que le
interese modificar.

Ya en ofro orden de cosas, nuestra aplicacion interacciona con el programa
XpipesCompiler, pero eso ya lo explicaremos mds tarde. Pero incidir una vez mds en que
el usuario puede crear una red de cero, y llamar con esa red a XpipesCompiler y
posteriormente a MPARM para poder optar a toda la funcionalidad de este programa,
ademds de poder tomar parte de la salida de éste dentro de nuestra herramienta con el
fin de observar algunos aspectos de rendimiento de la red que se ha definido. Por Ultimo,
tan sélo indicar que MPARM ofrece este resultado de rendimiento en archivos de texto,
por lo que necestamos que nuestro sistema sea capaz de parsear estos archivos para
mostrar resultados “graficos” de rendimiento.

3.2. Abrir una red ya existente y modificarla

Ni que decir tiene que nuestro sistema no se cife exclusivamente a la creacién de
nuevas redes partiendo de cero, sino que pretende ser capaz de leer un archivo de
definicion de una red y construir esta misma con todos sus componentes dentro de
nuestra aplicacion.

Asi, puede tomar archivos ya existentes, y construir la red “que se esconde” tras el texto.
Del mismo modo, toda vez terminado el trabajo con nuestra aplicacion podemos
guardar nuestra red “grafica” como archivo de texto.

Esto permite tomar un archivo de texto, traducir a nuestras redes que vemos y
modificamos en nuestra aplicacion, ver todos los aspectos de la red que enunciamos en



3.1., dejarla como nosotros queramos, y volver a trasformarla a archivo de texto,
sustituyendo por completo la labor de modificacion oscura y compleja de modificar las
redes trabajando directamente sobre el archivo de texto.

Nuestro sistema estd preparado para informar cuidadosamente al usuario de todo lo que
ha ocurrido durante la lectura del archivo de texto mediante un log que monitoriza el
proceso de lectura.

Ademds necesitamos ser capaces de leer estos archivos de texto para comunicarnos
con el programa SunFloor, cuya salida nos da una red en formato de estos archivos.

3.3. Interaccién con SunFloor

sPuede nuestro trabajo tener el humilde objetivo de colaborar al menos un poquito en la
labor de diseno de NoC 2 Creemos que si, en la medida de que sea capaz de
comunicarse con SunFloor y Xpipes.

El objetivo final del diseno de NoC es obtener un chip que contenga la red “a medida”
disenada. Bien, de esto, en parte, se encarga SunFloor. SunFloor es un programa que,
conociendo para qué tipo de aplicaciones serd utilizada nuestra red, sobre qué
tecnologia serd construida, ciertas caracteristicas de su IPs, asi como la frecuencia de
reloj a la que funcionard el chip, es capaz de generar la red, y su distribucion dentro del
chip.

Bien, zpues por qué no colaborar nosotros en el diseno de las tablas que especificardn
estos pardmetros de entrada? Permitiremos que el usuario construya estas tablas dentro
de nuestra aplicacion partiendo de cero, o que elija unas ya construidas y las modifique
a su gusto. Nuestra aplicaciéon se encargard de llamar a SunFloor una vez que el usuario
asi lo indigue.

sY por qué no utilizar también la salida de SunFloore Nuestra aplicacion recoge la red
generada por SunFloor, permitiendo trabajar con ella como ya explicamos en 3.2.
Ademdas mostramos el dibujo del FloorPlan, para que el usuario pueda conocer su diseno.

3.4. Interaccion con XpipesCompiler

Bien, sy qué mejor manera de conocer las caraceristicas de nuestro chip que
simuldndolo? Con ella podemos comprobar los resultados de nuestra red, completando
un trabajo que partié de un sencillo archivo de texto que definia nuestra red, o de la
nada en caso de construirla desde cero. Pero para poder simular, necesitamos codigo
que pasarle al simulador.

Para ello, nuestra aplicacion llamard a XpipesCompiler para obtener el coédigo SystemC
de nuestra red, y serd capaz de mostrarlo. Asi mismo llamard a MPARM para simular
nuestra red con el coédigo generado por XpipesCompiler, que no es ofra cosa que
comprobar su funcionamiento y rendimiento sobre una aplicacién real. MPARM
devolverd un archivo con el rendimiento de la red, y nuestra aplicacion serd capaz de
traducirlo para mostrar aspectos de rendimiento de un modo “grafico™.
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Mostraremos el resultado tanto si simulamos nuestra red sobre la conexion “cldsica” de
buses, como si lo hacemos sobre la nueva alternativa de las NoCs, y ofreceremos una
comparativa de ambos rendimientos para observar con cudl funciona mejor.

4. Estructura de las clases

Las clases de nuestra aplicacion pueden dividirse en tres grandes grupos segun su
funcion.

Por un lado tenemos las clases de fipo parse. Se encargan de leer los archivos de
enfrada, que tienen un formato concreto, y los transforman en datos legibles por nuestra
aplicacion.

Los principales parsers que tenemos son los de lectura/escritura de topologias, generado
completamente a mano para adaptarse perfectamente a la estructura de dichos
archivos; los de lectura/escritura de XML, generados usando la biblioteca Jdom; y por
ultimo el parse de lectura del fichero de estadisticas generado tras la simulacion,
mediante el que se obtienen los datos que se transforman posteriormente en tablas
visibles para el usuario.

El segundo gran grupo de clases son las clases grdficas. Estas a su vez podrian dividirse en
dos subgrupos: las clases de visualizacion y las clases de modificacion. Mientras las
primeras son las que permiten ver el estado de la red y los componentes que la forman
en todo momento, todo esto de dos formas distintas: mediante un grafo y un darbol; las
segundas son las que muestran al usuario toda la informacion de las caracteristicas de los
componentes y rutas, y le permiten modificarla a su antojo.

El Ultimo gran grupo de clases lo forman las clases relativas a la Iégica de la aplicacion.
Son las que mantienen los componentes, mantienen y modifican en estado de la red,
comprueban la infegridad de todas las operaciones que se realicen en la red. Son, en
definitiva, las clases que se encargan de realizar las operaciones pedidas por el usuario.

5. Como estd programado

Nuestra aplicacion se encuentra programada infegramente en Java. Elegimos este
lenguaje de programacion porque uno de los requisitos es que fuese una aplicacion
multiplataforma, y entre las diferentes opciones que se nos ofrecieron fue la que mds nos
gusto, por ser la que mejor conociamos.

Salvo para la muestra del grafo, que utilizamos SWT, nuestra interfaz grdfica estd
programada enteramente con Swing, ya que nos resultaba visualmente agradable,
ademds de ser ya conocido por nosotfros y cubrir, en principio, todas las necesidades que
ibamos a tener.
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Un factor que creemos destacable es que nuestra aplicacion, al igual que esta memoria,
estd desarrollada integramente en inglés, tanto la interfaz grafica que verd el usuario,
como el cédigo y los comentarios que veria un programador. Esto es asi porque nuestra
aplicacion tiene proyeccion internacional, y se espera que sea utilizada en entornos de
investigacion en diferentes paises, asi como que sus funcionalidades puedan ser
ampliadas por aquella persona que lo necesite, ya sea en Espana o en cualquier otro
lugar.

En cuanto a la organizacion del desarrollo, hemos utilizado Eclipse, ya que proporciona
comodidades y ayudas al programador, pero sobre todo porque tiene un buen sistema
de CVS, ademds de sencillo de usar. Esta Ultima caracteristica nos parecio importante, ya
que la coordinaciéon del desarrollo la realizamos a través de un CVS, para asi poder tener
en todo momento acceso a las Ultimas modificaciones, y que también el profesor
pudiera comprobar el desarrollo de la practica cuando deseara.
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1. INTRODUCTION

As steady progress is being made in the miniaturization of chip features, embedded
systems are quickly evolving towards complex devices, including a large set of
computation engines, dedicated accelerators, input/output controllers and multiple
memory buffers. MultiProcessor System-on-Chip (MPSoC) is a commonly used ferm to
describe the resulting outcome. However, this feature- and performance-oriented
evolution is not devoid of significant challenges, including mastering the increasing design
complexity and minimizing power consumption.

Moreover, miniaturization itself is bringing its own set of design issues at the physical level,
originated primarily by an increasing ratio of wire vs. logic propagation delay.

One of the most critical areas of MPSoC design is the interconnect subsystem, due to
architectural and physical scalability concerns. The former is due to the performance
pressure associated with several system cores that simultaneously demand
communication resources, and subsequently relates to the need for providing adequate
bandwidth and latency. The latter is due to the intrinsic issues due to the design of wires
that must span across the whole chip area, namely, propagation delay, noise and
crosstalk. Traditional shared bus interconnects are relatively easy to design, but do not
scale well.
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Fig 1.1 Motorola’s SoC platform. Communication architecture becomes
The major bottoneck.

Thus, evolutions have been conceived both from the protocol (e.g. outstanding
transactions with out-of-order delivery) and the topology (e.g. bridges, crossbars) points of
view. Nevertheless, scalability is still suboptimal, as protocol improvements still hit a
bandwidth limit due to the available physical resources, and topological extensions require
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the use of bridges (i.e. multiple buses or " “spaghetti-like" design (Fig 1.1)) or large area
overheads in routing structures (i.e. using crossbars).

Networks-on-Chip (NoCs) have been suggested as a promising solution

to the scalability problem. By bringing packet-based communication paradigms to the
on-chip domain, NoCs address many of the issues of interconnect fabric design. Wire
lengths can be conftrolled by matching network topology with physical constraints and
bandwidth can be boosted by increasing the number of links and switches.

Furthermore, compared to irregular, bridge-based assemblies of clusters of processing
elements, NoCs also help in tackling design complexity issues.

While these key advantages of NoCs have been largely accepted nowadays, the
practical implementation of NoCs in latest technology nodes is a very open challenge.
The crucial issue is again related to wiring and design automation. Even if capacitive loads
and propagation delays can be controlled much better than in shared buses, issues such
as manual wiring, definition of corrects buffers and switches to limit link power
consumption, and the need for placement-aware logic synthesis still have to be explored
to assess the feasibility of NoCs in forthcoming technology nodes.

In this infroduction we present the design flow for NoCs, and the necessity of developing
an application like NoCdificador. The remainder of the text is organized as follows. In the
next paragraphs we overview previous work in the field on on-chip interconnects in
general and, more particularly, focus on NoC synthesis and topology design and layout.
Then, we introduce the NoC design flow, and finally we explain how our application works
and how can it improve NoC's design.

1.1 Related work

The problem of high-performance or low-power synthesis of on-chip inferconnects based
on the bus paradigm has been studied extensively in the literature. The use of point-to-
point links and bus design using floorplan feedback has been also explored. Recent
research has focused on efficient synthesis methods for NoC-based interconnects and
comparisons with bus-based SoCs. Relevant research in application-specific custom
topology design has been proposed in earlier works on NoC design for well-behaved or
regular traffics.

Floorplanning estimations and analytical models have been employed during the
topology design process to obtain area and wirelength estimates, but these works are
limited to libraries of standard topologies. A physical planner has been used to focus on
minimizing power consumption on the links of NoC topologies. However, this method does
not consider the area and power consumption of switches in the design. In, a flow that
addresses the problem of full custom NoC topology design with early floorplan estimation
is proposed. However, even though these works have considered the various problems of
NoCs synthesis at the physical level, none of them has studied and covered extensively
the possible consequences of different process technology nodes on complete NoC-
based interconnects, as we present in this paper.

In addition, methods to build area and power models for various NoC components have
been developed to enable system-level exploration of SoCs using NoC interconnects.
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However, the existing area-power models of the NoC components, such as switches or
network interfaces, were not targeting the 65 nm manufacturing technology and may
need to be revised with the latest back-end tools to properly capture model requirements,
as we illustrate in our results.

At a higher level of abstraction, different methods have been proposed to analyze traffic
information and obtain models that can be utilized as inputs to bus and NoC design
methodologies. These approaches are complementary to this work. In addition, the
problem of supporting multiple applications has been studied. Also, methodologies that
unify resource reservation, mapping and routing in NoC designs have presented.
However, these works do not fully explore the topology design process.

Important research contributions have been presented on automatic code generation of
NoC topologies for simulation and synthesis. These works complement the presented one,
as their inputs are typically NoC designed topologies and even enable the use of post-
synthesis timing libraries in their simulation models.

A very interesting study on the impact of technology scaling on the energy efficiency of
standard topologies (such as meshes, tori and their variants) has been presented in
techscaling-standard. Our work differs from this research in two ways: first, we consider the
design of platform-specific NoC topologies and architectures. Second, we use a
complete design flow that is integrated with standard industrial toolchains to perform
accurate physical implementations of the NoCs.

1.2 Design flow

NoC designing is a hard, long task. The usual flow begins with the request of the different
features expected for the NoC, such as power, area, core specifications, and application
traffic. When these features have been fixed, the designer have to decide which
topology is going to be used, the mapping, routes to use... all these decisions are really
hard and depend on subjectivity of designer. Most of the times, the topology or routes
chosen are not the best. To solve this problem, an automatic tool is used to design a more
optimal topology than a hand-designed topology. This application is SunFloor.

With the topology generated by SunFloor, we can use another tool, xpipesCompiler, to
compile this fopology. After this step, RTL code will be generated for that NoC.

After compiling, the RTL code corresponding with our topology can be simulated with
different applications, in order to get statistical data about the performance of the NoC
designed by SunFloor. This simulations allows the designer improve the NoC, searching only
the elements that brings problems to the NoC.

If all data are correct, NoC is ready for synthesis and emulation on a FPGA. Finally, if there
are no problems after the emulation in FPGA, the NoC can be made on a chip.
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Hardware cost models

SUNFLOOR

U

Step 1 Step 2 Step 3

Fig 1.2 Usual design flow

1.3 NoCdificador

NoCdificador is the tool we have developed in this project. It is an application that allows
the designer create, modify, simulate... a NoC, assuring the correctness of the network.

Our application can interact with any phase of the design flow, except synthesis and
emulation, so it has 3 different inputs:

a) Topology files:

The first input can be a topology file. Our application validates the topology, and then
allows in a very easy, intuitive way to modify any feature or component in the NoC. In any
moment, the NoC can be complied and simulated.
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Topology

NoCdifica stats
dor

A 4
Xpipes Compiler

_ sistemC__ > MPARM

Fig. 1.3

b) Files with the characteristics wanted for the NoC.:

In this case, NoCdificador can generate a xml file containing the data requested, or can
open xml previously generated, and then generate the topology using SunFloor. This
topology is taken as the input file in case a) (See Fig 1.3)
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Fig. 1.4

c) New topology:

Finally, user can create a new topology, beginning from the very first step: give a name to
an empty network.

Detailed features are detailed in chapter 2 (User manual). Anyway, some of them are
going to be explained in this infroduction.

Topology files text files, but they are not easy to modify. Any modification on any element
of the NoC can have collateral effects on the rest of the elements in that NoC. A manual
control of all this changes is a very long task, and designer can easily make a mistake.
NoCdificador can make all this modifications, controlling collateral effects and assuring
the correctness of the NoC, informing about incomplete routes or elements, and can
make all this on an easy way thanks to his GUI.

A designer using NoCdificador can also have control of the elements on the NoC at any
moment. NoCdificador have different ways to show all the elements of the NoC: a tree or
a graph.

The user can also use XpipesCompiler and MPARM from NoCdificador to compile and
simulate the network. After simulation, NoCdificador shows with a clear format the results
of the simulation, even comparing different results. This visualization method is much more
easy to read than txt tables generated by MPARM.
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In conclusion, we think that our application is necessary due to the difficult method of
designing NoC that is being used nowadays. NoCdificador can help designers to finish
their NoC faster an easier.

19



2. USER MANUAL

In this section we want to give a guide for those who want to learn how to use
NoCdificador. We will begin on the main window, and then will explain the use of each

menu.

2.1 Main window

¢ MoCdificator

Fibe  Edit Wiew Componends  Simukasle Network  SunFloor  Graph  Stals  Help

Ve Xe - 05448

= T
rifaal Pocussors (1) | Bowcte |  Destinaion | BV B L [ Message ||
o [ Private memories () P P2 5 [1p o |

& () Shared mamaries (1)
o= [ Imterrupdions {13

o ) Semaphares (1)

o= 7 Linkes {6)

o [ Routas (24)

o= [ Switches (4)

= SunFioor spacification
[ epiications]
[ Tecnology
Dyirs

Buttons Bar: You get a ToolTip Text when you halts the pointer of the mouse over a
button.

Network tree: On the free you can see all the elements of the network, and make
any modification by double-click on the element you want to modify.
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[ 5=witch
- [ Processors (4)
D core 0
D core_1
D core_2
D core_ 3

o= [ Private memaoaries (2)
o= ] Shared memoaries (1)
& [ Interruptions (1)

o [ Semaphares (1)
o=[7] Links ()

o= ] Routes (24

&= [ Switches (4}

Sunfloor tree: Only active after invoking SunFloor. Allows watch the SunFloor
specification table by double click on the table.

iﬁ_ﬁ unFloor s“p_eciﬁcaﬁun
[ aplications
D Tecnolooy

| Y Ips

2.2 Open a network

There are two ways to open a network with NoCdificador:

2.2.1 Using Sunfloor:

To choose this option, go to SunFloor>LoadFiles

SunFloor | Graph
Load files

Show floor plan

Preferences.. F

And follow these steps:

1. Choose create/load an application table. You can open a default one, choose an
existing one or create a new one. Then press the next button.
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= SunFloor (0)

) Open an existing file
& Default file fexamplesicommspecs xml

©) Create anew File | Change Default ile

Choose or create an Aplications File... [Source Destination BW Lat Message]

| <gack || next> || cancer |

2. Fill the application table. You can create a new application or a new row into
the active application, or delete the active application or the selected row. Then
press the Next Button

2 SunFloor (1)

Mew Aplication Mew Row
Delete Aplication Delete Row
[ Sheet1 | Sheet3 | Sheetd.
|| Source Destination By Lat Message
IP1 12 i} 10 0
Corel Coreld a a 1
Corel Corel a a 1
Core2 Care2 a a 1
| < Back | | Mext = | | Cancel |

3. Choose create/load a technology table. You can open a default one, choose an
existing one or create a new one. Then press the next button.
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# SunFloor (2)

) Open an existing file
@ Default file Jeramplegiibspecs xml
! Create a new File Change Default file

Choose or create a Tecnology File... [Inputs Outputs Power Area Freg]

< Back I| Next > | Cancel ‘

4. Fill the technology table creating or removing rows in the table. To go on, press the
Next Button.

New Row

Delete Row

Inputs outputs Power Area Frem
1 8304762000, 69559599535 . |1230.457130
2 17.31047600... |1.516999999... [1139.140797
3 17.31047600... |1.516999908... [1139.140747
4 27.01714300... |2.4523E-2 1069.07131
5 27.01714300.. |2.4523E-2 1069.07131
|4}

T

2

L

3742476200, |3.505400000.. 1010
3AT.424TRZ00.. |3.505400000.. 1010
45.63333289.. |4 A7A199998 . |957.0957131

i} 49.53333200.. |4 A7H199998 . |957.957131
10 G0.34286700... |5.965000000... (3109067810,
11 G0.34285700... |5.965000000... ([S10.9067810..,
12 72858333300, |7.371400000... |367.6395184..
13 T2.88333300.. |F.371400000... |367.6395184..
14 SE.064TEZO0.. |B.895799908 . |32V 3673330,
SE.06476200... |B.895799998 . [B27. 3673330,
16 G9.87714280.. |0.10538 THY.64 2860
17 G9.87714280.. |0.10538 THA.642860
18 114.580476 0.122980000... [F53.767R020..,
14 114.580476 0.122980000... (7537676020,
20 129.9047620.. [0.1417458 T19.7406760...
1 17.31047600... |1 516939388 . [1139.140757

2 17.31047600... |1.516999988 . [1139.140797
3 270714300, |2.4523E-2 1069.07131
4 2701714300, |2.4523E-2 1069.07131
k) 3742476200, |3.505400000.. 1010

PR PRy S0 Ry ey e pare ey parg pary pary pare) pare parg pary par gy ey parg prg gy pary g pary pary
o

<

‘ < Back || fdeﬁis‘ || Cancel ‘

5. Choose create/load a technology table. You can open a default one, choose an
existing one or create a new one. Then press the next button.
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2 sunFlaor (4)

) Open an existing file
® Default file Jexamplesiipspecsxml
 Create a new File Change Default file |

Choose or create a IPs File... [CoreName Length Width]

| < Back H ﬁeﬁ?i || Cancel |

6. Fill the Ips table creating or removing rows in the table. Press Finish to save the tree
tables.

£ SunFloor (5)

New Row
Deleta Row
[ Core Name ] Length Width
P il 1
17 i 1
IP3 i Kl
P4 1 1

| <gack || Emsn || cances |

7. For each table, if it was opened you can rename or not rename it to save it with
another name, but if the table was created you must save it with a name.
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Sawing the Aplication fable

?r Rename the file?

Si || Mo

Saving the Tecnology table

- Fename the file?

El Ho

Saving the IPs table

? Rename the file?

Si || Mo

The tables will be saved into an XML format. There are two possibilities to save the tales:
save the tables with an XML format that can be opened with excel or openOffice 2.0
or save the tables info an XML normal format.(they won't be able to open with excel or
openOffice). For choose one of these options go to

SunFloor 2Preferences 2None/Excel

‘SunFloor | Graph Stats  Help
Load files e ‘

Show floorpian | ;
Preferences.. b Hone
ExceliOpenOffice

NoC frequency and the number of traffic generators must be specified now.

x|

= | Frecuency?
1400

| Aceptar |: Cancelar |
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x
mner_rs? Press CANCEL to skip this param

I Aceptar ; Cancefar |

If all the tables are correct, Sunfloor generates a net. In the main window you will see
the network tree, and below it there will be the Sunfloor free with its three tables. You
can see each table doing double click in its leaves.

¢ MoCdificator
Fibe  Edit Wiew Componends  Simukasle Network  SunFloor  Graph  Stals  Help

SRR F I =

:U.-l-';'ml'.:'!'l _Sl'pal;. eetd 7 Shﬂﬂl ] _ﬂﬁel,d”“ 4
it Puti ) | Bource | Destnaion | BW [ bl [ Message
o [ Private memories () 1 E2 5 [1o 1

& () Shanad mamorias (1)
o= (3 Interruptions {13

o= 7] Samapharas. (1)

&= [ Lirks {6)

o [} Routas (24)

o= ) Switches (4)

5] SunFroor spaciiic abion

[ Tecnology
Dyirs

If SunFloor has problems to generate the new net, warnings or errors will be shown into
the main window.
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I MaCdificator
File Edt View Components Sinuiste Nelwork SunFloor  Graph - Stats

&% e - 0%@&9@3

5 dgwiich WML Parsing ermarinside fite i’
o= ] Processors (4) Efror. Fili not found
&= 2] Privale meenionies (2) At lima @, colurmn 0

& (3 Shared memortes (1)
& ] infermuptions {1)

& 2 Sérmaphores (1)

o ] Links (6)

&= (O] Roules (24)

& (7] Swilchies (4)

£ SunfFloor specitcation
[ Apglications
D Tatnology

r:l i3]

You can cancel the Loading files operation in any moment. In this case, Sunfloor won't
generate the new network.

More options you can do this way:

* You can change the default path of each table, to open a default table which is
where you have chosen.

* You can go back to the previous step pressing the Back button.

* You can change the format of the XML files, to save the tables into an special XML
format that allows to open the tables with excel or openOffice
(SunFloor->Preferences>Excel/OpenOffice) or to save them into a normal XML
format. (SunFloor >PreferencesINone). You have to choose it before Load files if
you want to change it.

If SunFloor has success and the tables are correct, you can see the Floorplan
generated by SunFloor (SunFloor >Show FloorPlan) in the main window.

You can see the Log file too, in these cases, because the network’s file that Sunfloor
generates, will be opened by the program.
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To see the Log file go to: View >Log or press the Log button: 1

‘Miew | Components Simulat

Log
Incompleted components

Sunfloor applications
SunFloor tecnologny

SunFloor IPs

2.2.2 Opening a TXT net file (View the Standard format)

There is a Standard TXT Format for define a network.(View the Standard format).

To open a net go to File>Open Network or press the Open button: ‘lﬁ

_q_FiE_'| Edit View

e
Open network

ciose

D%y o

T T L

E=it

To define the network into the TXT file:

First, define the Topology, with the networks name and the topology type:
topology(net_Name, topology_type);

where topology_type only can be : other, mesh or torus.

Then, declare the cores, private memories, shared memories, semaphores and
interrupts with its correspondents afttributes.

28



For cores:

core(core_Name, NI clock divider ,Input buffers depth, NI buffers, type_core,
type_core?);

Where:

type_core only can be : userdefined or requested (if it is a specific one) and
type_core2 only can be : initiator or target.

For private memories:

core(pm_Name, NI clock divider, Input buffers depth, NI buffers, type_core, target :
mem_map);

Where:

type_core only can be : userdefined or requested (if it is a specific one) and
mem_map has this format: 0x00, 0x0T,....(is the memory mapping)

For shared memoiries:

core(shm_Name, NI clock divider, Input buffers depth, NI buffers, type_core, target :
mem_map -fixed);

Where:

type_core only can be : userdefined or requested (if it is a specific one) and
mem_map has this format: 0x00, 0x0T.,....(is the memory mapping)

fixed specifies that the memory position is fixed, only for shared and target cores.

For semaphores:

core(smm_Name, NI clock divider, Input buffers depth, NI buffers, type_core, target :
mem_map -fixed);

Where:

type_core only can be : userdefined or requested (if it is a specific one) and
mem_map has this format: 0x00, 0x01,....(is the memory mapping)

fixed specifies that the memory position is fixed, only for shared and target cores.

For interrupts:
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core(int_Name, NI clock divider, Input buffers depth, NI buffers, type_core, target :
mem_map -fixed);

Where:

type_core only can be : userdefined or requested (if it is a specific one) and
mem_map has this format: 0x00, 0x0T,....(is the memory mapping)

fixed specifies that the memory position is fixed, only for shared and target cores.

Then, declare the switches of the network and specifies its number of inputs, outputs
and buffers, and Xcoor and Ycoor if the topology Type is mesh or torus:

switch(switch_Name, inputs_number, outputs_number, Input buffers depth,
buffers_number);

switch(switch_Name, inputs_number, outputs_number, Input buffers depth,
buffers_number,Xcoor,Ycoor);

To Continue define the links between switches (and cores, pms, shms, ... and
swicthes).

You can't create a links between elements that don’t exist. You have to declare
them before.

link(linkName, element_source, element_target, number of repeaters);
Where:

element_source and element_target can be a switch or a type of core:
switch_Name, core_Name, pm_Name, shm_Name, smm_Name or int_Name.

Links between two switches or a switch and a core type are allowed. But links
between two types of core aren't.

If there are two links with the same Name and the element_source of one is the
element_target of the other and the element_target of one is the element_source of
the other, only a link with that Name will be created but it will be bidirectional.

To finish, declare routes:

A route has a source and a target(both must be core types) and the switches that
take part in the route (in the rigth order). The source, the target and the switches
have to be declared before.

route(coreType_Name, coreType_Name, switches: Namel, Name2,..NameN);
Where:

coreType only can be: core, pm, shm, smm or int.

And the Name of the switches can be its Name plus “.Letter” that means there is a
subchannel in that switch.
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Some Restrictions:

The black words are reserved words, and they mustn’t change.

Two elements of the same type with the same Name are not allowed. (Except if they
are links and the source and the target of one is the target and the source of the
other)

The Name of each element can be an String without -, (,), ;,:..and coma. The
name “null” is a reserved name for the attributes of the incomplete elements. It
means that the attribute with that doesn’t exist yet.

It is not necessary to create some elements of each type. You can only create the
topology to have a network file. But the topology must always be created in the
network file.

For more information, view some network TXT examples:

2switches. TXT

/1 rules: specify a topology name (and possibly type);
/] enter the cores first, then switches, then |inks

/1 assuming that first masters are entered, then the slaves in the //order as
/1 follows: masters, private nenories, shared nmenory, semaphore, interrupt

I R

/1 define the topol ogy here

/1 nanme, mesh/torus specifier (nesh/torus/other)
e

/1 Topol ogy:

t opol ogy(2swi tch, other);

/1 define the cores here

/1 core name and nunber, sw tch nunmber, N clock divider, N buffers,

/1 initiator/target type, type of core (if a specific one is //requested),
/1 menory mapping (only if target), fixed specifier

/1 (only if target and of shared type)

/1 Cores:
core(core_0, 1,2, 6, userdefined, initiator);
core(core_1, 1,2, 6, userdefined, initiator);

/1l Private Menories:
core(pm2, 1,2, 6, userdefined, target:0x00);
core(pm3, 1,2, 6, userdefined, target:0x01);

/1 Shared Menori es:
core(shmd4, 1,2, 6, userdefined, target:0x19-fixed);

/1 Semaphores:
core(smmb5, 1,2, 6, userdefined, target:0x20-fixed);

/1 Interrupts:
core(int_6, 1,2, 6, userdefined, target:0x21-fixed);
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/1 define the switches here

/1 switch nunber, switch inputs, switch outputs, nunber of buffers,

/1 x coordinate (only if nmesh/torus), y coordinate (only if //mesh/torus)
/1 coordinates are from upper left corner, counting fromO included

N R

/1 Switches:

switch(switch 0, 3, 3,2, 5);

switch(switch_1, 6, 6,2, 5);

N R
/1 define the links here

/1 link nunmber, source, destination
e
/1 Links:

[ink(linkO, switch_0, switch_1,0);
nk(linkl, switch_ 1, switch_0,0);
nk(linkOc, core 0, switch 0,0);
nk(linklc, core_ 1, switch_ 0, 0);
nk(link2pm switch_1, pm2,0);
nk(link3pm switch_1, pm3,0);
nk(link4shm switch_ 1, shm4,0);
nk(link5smm switch 1, smm5,0);
nk(link6int, switch 1, int_6,0);

/1 define the routes here

/1 source core, destination core, the order in which switches need to //be
/1 traversed fromthe source core to the destination core
e

/1 Rout es:

route(core_0, pm?2, switches:0, 1);

route(core_0, shm4, switches:0, 1);

route(core_0, smmb5, switches:0, 1);

route(core 0, int_6, switches:0, 1);

route(core_1, pm3, switches:0, 1);

route(core_1, shm4, switches:0, 1);

route(core_1, smmb5, switches:0, 1);

route(core_1, int_6, switches:0, 1);

route(pm?2, core_0, switches:1, 0);

route(pm3, core_1, switches:1, 0);

route(shm4, core_0, switches:1, 0);
route(shm4, core_1, switches:1, 0);
route(smmb5, core 0, switches:1, 0);
route(smmb5, core_1, switches:1, 0);
route(int_6, core_0, switches:1, 0);
route(int_6, core_1, switches:1, 0);
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Another example more complex is sunfloorNet.TXT :

t opol ogy(t opol ogynane, other);

core(core_ 0, 1, 2, 6, userdefined, initiator);
core(core_1, 1, 2, 6, userdefined, initiator);
core(core_2, 1, 2, 6, userdefined, initiator);
core(core_3, 1, 2, 6, userdefined, initiator);
core(core_4, 1, 2, 6, userdefined, initiator);
core(core 5, 1, 2, 6, userdefined, initiator);
core(core_6, 1, 2, 6, userdefined, initiator);
core(core_7, 1, 2, 6, userdefined, initiator);
core(core_8, 1, 2, 6, userdefined, initiator);
core(core_ 9, 1, 2, 6, userdefined, initiator);
core(core_10, 1, 2, 6, userdefined, initiator);
core(core_11, 1, 2, 6, userdefined, initiator);
core(core_12, 1, 2, 6, userdefined, initiator);
core(core_13, 1, 2, 6, userdefined, initiator);
core(core_14, 1, 2, 6, userdefined, initiator);
core(pm115, 1,2, 6, userdefined, target:0x00);
core(pm16, 1,2, 6, userdefined, target:0x01);
core(pm117, 1,2, 6, userdefined, target:0x02);
core(pm18, 1,2, 6, userdefined, target:0x03);
core(pm19, 1,2, 6, userdefined, target:0x04);
core(pm20, 1,2, 6, userdefined, target:0x05);
core(pm?21, 1,2, 6, userdefined, target:0x06);
core(pm?22, 1,2, 6, userdefined, target:0x07);
core(pm?23, 1,2, 6, userdefined, target:0x08);
core(pm?24, 1,2, 6, userdefined, target:0x09);
core(pm25, 1,2, 6, userdefined, target:0x0a);
core(pm26, 1,2, 6, userdefined, target:0x0b);
core(shm?27, 1,2, 6, userdefined, target:0x19-fixed);
core(smm?28, 1,2, 6, userdefined, target:0x20-fixed);
core(int_29, 1,2, 6, userdefined, target:0x21-fixed);
switch(switch 0, 6, 5,2, 4);

switch(switch_1, 6, 6,2, 4);

switch(switch_2, 4, 4,2, 4);

switch(switch_3, 11, 8,2, 4);

switch(switch 4, 9, 9,2, 4);

switch(switch 5, 6, 8,2, 4);

switch(switch 6, 6, 8,2, 4);

link(link_ 0O, core_ 0, switch_ 3, 0);

link(link_1, switch_3, core_0, 0);

link(link 2, core_ 1, switch 1, 0);

link(link 3, switch 1, core_1, 0);

link(link 4, core 2, switch 0, 0);

link(link_ 5, switch_ 0, core_2, 0);

link(link_ 6, core_3, switch 5, 0);

link(link 7, switch 5, core_3, 0);

link(link 8, core 4, switch 6, 0);

link(link 9, switch 6, core_4, 0);

link(link_10, core_5, switch_0, 0);
link(link_11, switch_0, core_5, 0);
link(link 12, core_6, switch_6, 0);
link(link 13, switch_6, core_ 6, 0);
link(link_ 14, core_ 7, switch_3, 0);
[ink(link_15, switch_3, core_7, 0);
link(link_16, core_8, switch_1, 0);
link(link 17, switch_1, core_8, 0);
link(link 18, core_ 9, switch_ 5, 0);
link(link 19, switch_5, core_ 9, 0);
link(link_ 20, core_10, switch_4, 0);
link(link 21, switch_4, core_10, 0);
link(link 22, core_11, switch_ 2, 0);
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ink(link 23, switch 2, core_11, 0);
ink(link_24, core_12, switch_4, 0);
i nk(l'ink_25, switch_4, core_12, 0);
ink(link 26, core_13, switch_2, 0);
ink(link 27, switch 2, core_13, 0);
ink(l'ink_28, core_14, switch_2, 0);
ink(link_29, switch_2, core_14, 0);
i nk(l'ink_30, pm15, switch_3, 0);
ink(link 31, switch 3, pm15, 0);
ink(link 32, pm16, switch_1, 0);
ink(link_33, switch_1, pm.16, 0);
ink(link_34, pm17, switch_0, 0);
ink(link_35, switch_ 0, pm17, 0);
ink(link 36, pm18, switch 5, 0);
ink(link 37, switch 5, pm18, 0);
ink(link_38, pm19, switch_6, 0);
ink(link_39, switch_6, pm19, 0);

i nk(link_40, pm 20, switch_0, 0);
ink(link 41, switch 0, pm20, 0);
ink(link 42, pm21, switch_6, 0);
ink(link_43, switch_6, pm21, 0);
ink(link_44, pm22, switch_3, 0);

i nk(link_45, switch_3, pm22, 0);
ink(link_46, pm23, switch_1, 0);
ink(link 47, switch_ 1, pm23, 0);
ink(link_48, pm24, switch_5, 0);
ink(link_49, switch_ 5, pm24, 0);

i nk(l1ink_50, pm25, switch_4, 0);
ink(link 51, switch 4, pm25, 0);

i nk(link 52, pm26, switch_ 2, 0);
ink(link_53, switch_2, pm26, 0);

i nk(l'ink_54, shm 27, switch_4, 0);
i nk(l'ink_55, switch_4, shm 27, 0);

i nk(link 56, smm 28, switch 4, 0);
ink(link 57, switch 4, smm 28, 0);
ink(link_58, int_29, switch_3, 0);
ink(link_59, switch_3, int_29, 0);
i nk(1ink60, switch_0, switch_3, 1);
i nk(link6l, switch_1, switch_3, 1);
i nk(link62, switch_1, switch_4, 1);
i nk(l1ink63, switch_3, switch_4, 1);
i nk(l1ink64, switch_3, switch_5, 1);
i nk(1ink65, switch_3, switch_6, 1);
i nk(l1ink66, switch_4, switch 0, 1);
i nk(l1ink67, switch_4, switch_1, 1);
i nk(1ink68, switch_4, switch_5, 1);
i nk(1ink69, switch_4, switch_6, 1);
i nk(1ink70, switch_5, switch_1, 1);
i nk(link71, switch_ 5, switch_3, 1);
i nk(link72, switch_5, switch_3, 1);
i nk(l1ink73, switch_5, switch_4, 1);
i nk(l1ink74, switch_6, switch_0, 0);
i nk(1ink75, switch_6, switch_3, 1);
i nk(l1ink76, switch_6, switch_3, 1);
link(link77, switch 6, switch 4, 1);
route(core_0, pm15, switches: 3);
route(core_0, shm?27, switches:3, 4);
route(core_0, snm 28, switches:3, 4);
route(core_0, int_29, swtches:3);
route(core_1, pm16, switches:1);
route(core_1, shm?27, switches:1, 4);
route(core_1, smm 28, switches:1, 4);
route(core_1, int_29, switches:1, 3);
route(core_2, pm17, switches:0);



route(core_2, shm27, switches:0, 3, 4);
route(core_2, snm28, switches:0, 3, 4);
route(core_2, int_29, switches:0, 3);
route(core_3, pm18, switches:5);
route(core_3, shm27, switches:5, 4);
route(core_3, snm 28, switches:5, 4);
route(core_3, int_29, switches:5 B, 3);
route(core_4, pm19, switches:6);
route(core_4, shm27, switches: 6, 4);
route(core_4, smm 28, switches: 6, 4);
route(core_4, int_29, switches:6.B, 3);
route(core_5, pm20, switches:0);
route(core_5, shm?27, switches:0, 3, 4);
route(core_5, snm 28, switches:0, 3, 4);
route(core_ 5, int_29, switches:0, 3);
route(core_6, pm?21l, switches:6);
route(core_6, shm?27, switches:6, 4);
route(core_6, smm 28, switches:6, 4);
route(core_6, int_29, switches:6.B, 3);
route(core_7, pm?22, switches: 3);
route(core_7, shm?27, switches:3, 4);
route(core_7, smm 28, switches:3, 4);
route(core_7, int_29, swtches:3);
route(core_8, pm?23, switches:1);
route(core_8, shm27, switches:1, 4);
route(core_8, snm 28, switches:1, 4);
route(core_8, int_29, switches:1, 3);
route(core_9, pm?24, switches:5);
route(core_9, shm27, switches:5, 4);
route(core_9, smm 28, switches:5, 4);
route(core_9, int_29, switches:5 B, 3);
route(core_10, pm 25, swi tches:4);
route(core_11, pm 26, sw tches:2);
route(core_12, pm 25, switches: 4);
route(core_12, shm 27, swtches:4);
route(core_12, smm 28, switches:4);
route(core_13, pm 26, sw tches:2);
route(core_14, pm 26, sw tches:2);
route(pm15, core_ 0, switches: 3);
route(pm16, core_ 1, switches:1);
route(pm17, core_2, switches:0);
route(pm18, core_3, switches:5);
route(pm19, core_4, switches:6);
route(pm 20, core 5, switches:0);
route(pm?21, core 6, switches:6);
route(pm?22, core_7, switches:3);
route(pm23, core_ 8, switches:1);
route(pm?24, core 9, switches:5);
route(pm25, core_ 10, switches: 4);
route(pm?25, core_ 12, switches: 4);
route(pm26, core_11, swi tches:2);
route(pm26, core_13, swi tches:2);
route(pm26, core_14, swi tches:2);
route(shm?27, core_ 0, switches:4, 5 A 3);

route(shm?27, core_1, switches: 4, 1);
route(shm?27, core_2, switches:4, 0);
route(shm?27, core_3, switches:4, 5);
route(shm?27, core_4, switches:4, 6);
route(shm?27, core_ 5, switches: 4, 0);
route(shm?27, core_6, switches: 4, 6);
route(shm?27, core_7, switches:4, 5 A 3);
route(shm?27, core_8, switches:4, 1);
route(shm?27, core_9, switches:4, 5);

route(shm?27, core_12, switches: 4);
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route(smm 28, core_0, switches:
route(smm 28, core_1, switches:
route(smm 28, core_2, switches:
route(smm 28, core_3, switches:
route(smm 28, core_4, switches:
route(smm 28, core_5, switches:
route(smm 28, core_6, switches:
route(smm 28, core_7, switches:
route(smm 28, core_8, swtches:
route(smm28, core_ 9, switches: 4, 5);
route(smm 28, core_12, switches:4);

route(int_29, core_0, switches:
route(int_29, core_1, switches:
route(int_29, core_2, switches:
route(int_29, core_3, switches:
route(int_29, core_4, switches:
route(int_29, core_5, switches:
route(int_29, core_6, swtches:
route(int_29, core_7, switches:
route(int_29, core_8, switches:
route(int_29, core_9, switches:
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The TXT file won't be opened if the file hasn't a defined topology in if. In other case the net
will be opened. If there are errors in some element’s declarations, these elements won't
be created and NoCdificador advises you to check these errors looking the Log

(View>Log or with the Log button : 1)

Miew } Components  Simulat

Log
Incompleted components

SunFloor tecnology

View Log File

When a txt network file is opened a new File is created at the same path with the
name of the first one plus "“_Advise”. This new file shows the possible errors or the
actions that have been occurred during the opening of the net. You can see this file
from the Nocdificador’'s main window (View 2>Log)
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Mo dilicator

File Edft Wiew Cormponents  Siodate  Metwork  SunFloor  Graph Stals  Help

SeoFe- e hd8s0r

3 5swdch HReading ihe fe CADocuments and SeEnglauiMiE SECUmEmMasiSswitches. i 5:,-
o= ] Processors (4) |
& [ Private memones () | [MEW NET Glne 12 TOPOLOGY NAME: Sswitch | TOPOLOGY TYPE: oitver
& 23 Shared menvonies (1}
o ] Infermupbions (1)
o= [ Semaphores (1)

VAMEW CORE (Hine 23y ATTRIBUTES 0 1.0 6, userdefined | inilator
MEY CORE (ni24 ) ATTRIBUTES: 1 1.0, 6§ , userdefingd , inibiator
HEW CORE (bne 25y ATTRIBUTES: 2 1.0, 8, usbrdefined | Initiator

& [ Links (B) [{MEW CORE fine 26) ATTRIBUTES: 3, 1.0 6, userdefined, iniialor
o [ Routes (24) | [MEYY PRIVATE MEMOR Y line 20 ) ATTRIBUTES. 2, 1.0, 8, userdefinad , 00 Talse .
o ] Swiches (4 | {MEWY PRIVATE MEMORY{line 30) ATTRIBUTES: 3, 1.0, 5, userdefingd , 81 false

MEWY EHARED MEMORY (fns 32 ) ATTRIBUTES: 4 1.0, %, userdefined, 19, frpe
| IMEYY SEMARPHORE (lirie 36 ) ATTRIBUTES: & 1.0 &  uzerdefined , 30 true
LNEYY INTERRLUPT (linie 39) ATTRIBUTES 6, 7.0°, &, userdefingd, 27, rue
PINEW SWATCH (line 43y ATTRIBUTES 0, 3
[|MEW SWITCH (ling 49 ) ATTRIBUTES. 1 .6
[

| MEW SWITCH (line 50 ) STTRIBUTES 2, 3
| {MEWE SWATCH (ling 51 } ATTRIBUTES: 3,
RIEWY LEMK (lirie 55 ) ATTRIBUTES 0.0,
| {PEW LENK flime S5 ) ATTRIBUTES:1 1,
| {rERY LENK (line B0 YATTRIBUTES 2,1,
MEW LENK (firie 84 ) ATTRIBUTES: 3,1,
[ IMEYY LINK (ling 62 ) ATTRIBUTES: 4,3,
| MW LENK (lire B2 Y ATTRIBUTES 5.2,
{ [MEWY LiNE BETWEEN (line 64 J ATTRIBUTES 0, swatch_0
| {NEWY LiNK BETWEEN (ling 85 ) ATTRIBLITES 1 , swilch_0
| {MEW LiNK BETWEEN (line 68 ) aTTRIBUTES: &, swifch_2
i HEW LENK BETWEEN (line 57 ) ATTRIBUTES. 3, swilch_3
{|HEW LENK BETWEEN (line 82} ATTRIBUTES: 2, $wilth_1
| [FEWY LINK BETWEEH (linie §9) ATTRIBUTES: 2, swilch_3
[ {MEW LBNK BETWEEM (line 70 ) ATTRIBUTES: 4 , swiich_1 L
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2.3. Create a new network

To create a new net go to File >New or press the New network button:

Open network
Close

Save
Save as.,.

Exit

It is necessary fill the network’s name and choose the type of the topology (others,
mesh or torus)
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Het Hame :

Topology :

Accept

rienaefs et

If the type is others the net will be created empty, only with that name and that

topology type.

Het Hame : nels et
Topolomy : Ii#hﬂfﬁ
&ccept Cancel
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If the type is mesh or torus you must fill the Dimension gaps and the switch’s attributes
(number of inputs, outputs and buffers).

Het Hame : new-let |
Topoloogy : mesh -
Accept Cancel

Wide Dimension : 2
High Dimension ; 2
Switch inputs 4
Switch outputs 4 |
Humber of buffers 4 |

Minimum allowed dimension is 2 x 2 and minimum inputs and outputs for the switches
are 4.
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Het Name ; rewiflet

Topolooy : mesh -

%-n[:c:epti Cancel

Bad Dimensions or Values

Wide Dimension : !2
High Dimension : i1
Switch inputs !4
Switch outputs 4
Humhber of huffers !4

In this case the net will be created with that name, that topology type and only with
the switches and the links between them (depends on the topology type, mesh or
torus)

2.4 Modify the network

To modify the net, the net must be opened or created. There are many ways for
modify the net:

[ Change the network’s name

0 Create a new network’s element

O Modify an existing network’s element
0 Delete an existing Network’s element
O Undo and Redo actions
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2.4.1 Change the network's name

To change the name of the net go to Network->Change net name.

Fﬁmurls; | SunFloor

Type of network
Change net name

This is a simple modify and you couldn’t undo this change, To undo it change the
name again.

-5 Metwork MName :

|sswitch] |

Aceptar Cancelar

2.4.2 Create a new network's element

To create a new element in the net go to Components>New Component and
choose the type of component you want create,

‘Compenents | Simulat
Modify component

Delete component

Or press the New Component Button: ﬁ

These are the component types: core, private memory, shared memory, semaphore,
interrupt, switch, link and route.
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£ Create New Component

Components:

@ Core

i Privated Memory
i1 Shared Memory
i_) Semaphore

{1 Interruption

i Switch

1 Link

{_) Route

Switches must be created before

Accept Cancel

If there aren’t any switches in the net you will have to create them before create
other elements.

Restrictions for the new components:

Don’'t use the same name for a new component if exists other of the same type with
that name.

Fill all the gaps for the afttributes of the component.

If the new component is a Route the source of it has to be initiator type and the
target has to be target type. Also its switches list mustn’'t be empty. But it can be
wrong connected, in this case the route will be created but it will be an incomplete
route.

The used outputs and inputs of the switches can cause problems when a new core,
private memory, shared memory, semaphore or interrupt is created with an
associated switch that has all its connection busy. The same happens when a link is
going to be created between two switches that have all its outputs and inputs full.

In all these cases if the new component has its attributes are correct, it will be created in
the network. Then you can modify or delete it.

2.4.3 Modify an existing network’s element
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To modify an existing element in the net go to Components>Modify Component
and choose the type of component you want modify.

'ﬁhﬁ’lﬁhﬁéﬂfﬂ Simulat)

Hew component
Modity camponer
Delete component

Or press the modify component button: | ™

These are the component types: core, private memory, shared memory, semaphore,
interrupt, switch, link and route.

You can't modify a type of component if there isn't any component of that type in
the net. If any component of the chosen type exists you can modify it choosing it
between all the components of the same type.

2 Mo dify Component E| |§;E|

Coemponents:

(_r Core

i) Privated Memory

i) Shared Memory

{_r Semaphore

() Interruption

 Switch

i Link

% Route

There aren't Rowtes for modify

Accept Cancel

Other way more direct to modify it is doing double click on the component (On the
component’s leaf in the network’s tree at the main window or on the component’s
node of the network’s graph).
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] Aswitch
9 [ Processars (4)

[ Fore 0]
|j| core 1
|j| core_2
|j| core_ 3
o= [ Private memoaries (23
o [ Shared memoaries (13
o= ] Interruptions (1)
o= ] Semaphores (1)
o~ [ Links (&)
o [ Routes (24
o= [ Switches (4)

The restrictions for modify a component are the same that for create it. But if the
component is incomplete, you could modify it even without specifying its incomplete
attributes.

0 Modify some attributes of the components can cause that other components
turn info incomplete components:



[l Modify the associated switch of a core, pm, shm, smm or int causes the routes
where it fook part turn into incomplete routes.

[l Modify the target or the source of a link causes the routes where it took part turn
into incomplete routes.

[ Modify the switches list of a route can causes that route turns intfo incomplete
route, if the switches list is a wrong list because of there isn't all the connections
between its switches.

1 Modify the number of inputs or outputs of a switch can cause problems if all its
connections are used.

2.4.4 Delete an existing Network's element

To delete an existing element in the net go to Components>Delete Component and
choose the type of component you want delete.

‘Components | Simulat

Mew component
Modify component

Delete component

Or press the delete component button: | g I

These are the component types: core, private memory, shared memory, semaphore,
inferrupt, switch, link and route.

You can't delete a type of component if there isn’'t any component of that type in

the net. If any component of the chosen type exists you can delete it choosing it
between all the components of the same type.
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£ Delete Com ponent

Components:

i Core

{_ Privated Memory
2 Shared Memory
(' Semaphore

() Interruption

) Switch

® Link

_’ Route

There aren't Links for delete

Accept Cancel

Other way more direct to delete it is doing double click on the component (On the
component’s leaf in the network’s tfree at the main window or on the component’s
node of the network’s graph).

] Aswitch
9 [ Processars (4)
Dicure_;ﬂ
|j| core 1
|j| core_2
|j| core_ 3
o= [ Private memoaries (23
o [ Shared memoaries (13
o= ] Interruptions (1)
o= ] Semaphores (1)
o= [ Links (&)
o [ Routes (24
o= [ Switches (4)
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BX

M Sswitch

There isn't a restriction for delete an existing component, but it can cause that other
components furn into incomplete components:

0 Delete a core, private memory, shared memory, semaphore or interrupt makes
the routes where it took part turn into incomplete routes.

0 Delete a link makes the routes where it took part turn into incomplete routes.
11 Delete a switch makes:

o Routes where it took part turn into incomplete routes.

o Links where it was the source or the target turn into incomplete links.

o Cores, pm, shm, smm, int where it was the associated switch turn into
incomplete components.

O Delete a route doesn’t cause these problems.

2.4.5 Undo and Redo actions
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You can undo and redo the last three changes of create, modify and delete
components in the net.

To undo a change happened in the net go to Edit [1Undo or press the Undo Button:
.‘_
Edﬁj\ﬂem

Lndo
Redo

To redo an Undo action before go to Edit>Redo or press the Redo Button :

—

iiﬁ;}\ﬂe1
Undo
Redo

Change the net name can’t be undo or redo, but it is a simple change that can be
resolved changing the name of the net again.

2.5 View information about the network

There is much information about the network that you can see with NoCdificador. To
see it the net must exist, it has to have been created or opened before.

[ View the network’s topology

[] View the Log

[ View Information about each component

[] View Incomplete elements

[] View SunFloor tables

[ View the FloorPlan

[] Simulate the Routes

[ View the network’s Graph
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[ View Xpipes and AMBA Stats

2.5.1 View the network’s topology

To see the topology type of the net go to Network->Type of network.

Hetwork | SunFloor
Type of network
Change net name

The topology type only can be: others mesh or torus. The last two ones make the net
have a non-uniform structure, but with the fist one the net will have another structure,
not uniform.

Mensaje

.l'f'
k\D Hetwork Type : OTHERS

fceptar

2.5.2 View the Log

The Log is a file that is created when a net is opened. The Log has all the information
about the opened net and also the possible errors of its structure or format.

This file can be helpful for check the errors of the format network file because it

adyvises of the errors, shows in where line of the file they are, and what type of error is.
To see it go to View>Log.

Eﬁa@.‘r'_| Components Simulat
Log
Incompleted components
Sunfloor applications

SunFloor tecnolomy

Sunfloor IPs

Or use the Log button: f

Even the file hasn't errors, looking the Log you can see in which line each element
has been created and its attributes.
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File EdAd View Composents  Siondate Nelweork  SunFloor  Graph Stals  Help

Jode - 54480000

3 S=wdch HEgading the #e CDocuments &nd SelngsilauiMis decumenosSswitches. b Il
o= [ Protessors (4) |
& [ Private memones (1) MEWY NET (re 12)  TOPOLOGY MAME: Sswitch | TOPOLOGY TYFE: olver
& 23 Shared menvonies (1)

= [ Infermugions {1} (KEW CORE (line 23 ) ATTRIBUTES 0 1.0 6, userdefined , inifistor

MEWY CORE (Eni-24) ATTRIBUTES! 1, 1.00, 6, userdefingd , inibialor

& [ Semaphares (1) [IHEW CORE (Hine 25y ATTRIBLTES. 2 1108, userdefined | Intiatar
&= [ Links (B} MEW CORE (e 26) ATTRIBUTES: 3, 1.0 5 , userdefingd, Initialor
o [ Routes (24) | [MEYY PRIVATE MEMOR Y line 20 ) ATTRIBUTES. 2, 1.0, 8, userdefinad , 00 Talse
o= 7] Ewiichies (4 FIEWY PRIVATE MEMORY(line 30) ATTRIBUTES: 3, 1.0, 5, userdefined , 01 , falze

REW EHARED MEMORY (fire 33 ) ATTRIBUTES: 4 . 1.0,%  userdefingd, 19, s

MEWY SEMAPHORE (line 36 ) ATTRIBUTES 5, 1.0 & uzerdefinad , 20 true

LNEYY INTERRLUPT (linie 39) ATTRIBUTES 6, 7.0°, &, userdefingd, 27, rue

HEW EWITCH (line 48 YATTRIBUTES 0,3,

MEYY SWITCH (line 49 ) ATTRIBUTES 1 &,
B,

3,5
1,6.6,5
| IMEW SWITCH (ine 50 ATTRIBUTES: 2, 3.3 ,5
| {raEwy SWATEH (ling 51 ) ATTRIBUTES 3. 5,8, 5

PEWY LEME (ine 52 ) ATTRIBLTER 3,0,
1.,
E,

PIEW LENK {line 59 % ATTRIBUTES: 1 |

FEWY LENK {line B0 ) ATTRRBUTES I,

PIMEWY LENE fline 84 ) ATTRIBUTES: 3,1, 2

|| MEYY LENF fling B3 ) ATTRIBUTES: 4,3 ,2

| IMEW LENK (lire B2 Y ATTRIBUTES 5.2, 0

: FIEWY LINE BETWEEMN (line 64 JATTRIBUTES: 0, swilch_0
MNEWY LMK BETWEEMN (ling 65 } ATTRIBLITES: 1, Swilch_0

PEW LENK BETWEEMN (line 68 ) ATTRIBUTES: I |, swilch_2

FEEWY LENK BETWEERN (line &7 | ATTRIBUTES. 3, swilch_3

| IHEW LENI BETWEEN (line B33 ATTRIBUTES: 2, swilth_1

MEWY LENK BETWEEN (line 63 ) ATTRIBUTES: 2, swilch 1

| [HEW LINIK BETWEEM (line 70 ) ATTRIBUTES 4 | swilth_1

D T e L s T T L | Lad

1
i
3

You only can see the Log if a net has been opened from a file or by SunFloor, not if it
has been created by you from NoCdificador.

2.5.3 View Information about each component

To see the attributes of each network’s component do double click on it (On the
component’s leaf in the network’s tfree at the main window or on the component’s
node of the network’s graph). A new window shows its characteristics.

[ 5awitch
9 [ Pracessors (4)

|j| core 1
D core_2
|j| core 3
o= 7] Private memaries (2
o= ] Shared memaries (1)
o ] Interruptions (1)
o [ Semaphares (1)
o= 7] Links (&)
o= ] Routes (24)
& [ Switches (4)
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£ Core's Information

General | Others |

General Properiies:
Mame: core_1
Switch: 0
Clock divider : 1.0
Humber of Buifers: 6

Type of core : userdefined and inftiator

Lccept Modify Delete

Also you can see other relational information about it in that window
choosing “Other”:
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% Care's Information

General || Others |

Routes in which it take part:

1.Route 8

2.Route 9

3.Route 10
4.Route 11
.Route 13
Route 17
.Route 21
.Route 23

Accept Modify Delete

Other information about a:
0 Core, pm, shm, smm or int is the routes where it takes part.
0 Switch is the routes where it takes part.
O Link is the routes where it takes part.

0 Route is the links that take part on it.

£ Private Memory's Information

General | Others |

General Properties:
Mame ; pim_2
Switch: 1
Clock didder : 1.0
Number of Buffers : 6
Twpe of memory : userdefined
Memony mapping 00

Accept | Modify Delete

£ Private Memory's Information

General | ‘Others.

Rowutes in which it take part:
1.Route 0
2.Route 4
F.Houte 12

4.Route 14

Accept Modify Delete
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Link's Information

| General | Others |

Hame : linkD
Source ; switch_0
Destination : switch_1

Bidirectional

General Properiies:

Accept

Mclify Delete

£ Link's Information

General | Others

Route
1.Route 0
2 Route 1
3.Route 2
4Route 3
5.Route 4
6.Route 5
7.Route 6
8 Route 7
LJ_I:I..-.-.J._\_F"

% in which it take part:

4

Accept

Modify Delete

Route’s Information

| General i Dthers_|

General Properties:

Hame:core_Jtoint_6 (
Source: 3

Destination : 6

Switches :

3-2-0-1

7)

Accept

Modify Delete
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o = D o i

General |["Others

Links in this route:

1.Link 4

Link 5

Link 0

Accept Modify Delete

i Switch's Information

_[fzﬁeneral I Others |

General Properties:
Hame : switch_0
Inpuis ;3
Outpunis ; 3
Humber of Buifers: 5

Lccept Modify | Delete |

 General | Others

| Routes in which it take part: ac
E.qute 1]

.Route 1
Route 2
Route 3 H
Route 4
6.Route 5
Route 6
Route 7

{ o TR G . 1

1|

Accept Modify Delete

From that new window you can modify or delete the component too.

2.5.4 View Incomplete elements

The net can have incomplete elements that have any of its attributes undefined or
wrong defined (like routes that have its switches list wrong connected).

You can see all these incomplete components go to View->Incomplete
Components.
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wa Components  Simulat

i S T P

L8] 41

SunFloor applicati
SunFloor tecnology
SunFloor iPs

These components will be showed in the main window. It can be useful for known
what components are incomplete in the net and complete them.

© MoCdificator.
File Edit View Componenis Shmulate Metwork Sunflomr Graph Stats  Help

Yo Be - - 05448

=] Sswitch INCOMPLETED COMPONENTS.
o o Processors {4)
&= [ Private memories (2 CORES
o= [ shased rgrmaries (1) Thard arenincomplatad corés
o 2 Intarmaptions (1)
& [ Semaphores (1)

Tr

PRIVATED MEMORIES

- m Linikos {6:' Thare arent incompletad prvated MEmanes
o Y Routas [24)

o [ Swilches (4)
EHARED MEMORIES:
Tharg arenincormpleted shared Memaries

SEMAPHORES
Thare arentincornpleted Semaphores

NTERRUPTE
There arent incornplatad inferrupts

LINKE
Therg arent incomplebad Links

ROUTES

pro_2 o eore 00018
prr_Sbo coré 1 (13
pri 2 bo core 2 {14}

Lo A munamms S i B

2.5.5 View SunFloor tables

When a net has been opened with SunFloor you can see its SunFloor Tables
(application table, technology table and Ips tables).

To see them go to View—=>SunFloor applications, View->SunFloor technology or View
2>SunFloor Ips.
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| Compohents  Simulat

Log

Incompleted components

SunFloor applications
SunFloor tecnology
SunfFloor IPs

In each case you can see each table in the main window.

Other way to see them is doing double click on each leaf (applications, technology
or IPs) of the SunFloor tree that is in the main window too, above the network’s free.

¢ MoCdificator
Fibe  Ecit “iew Compomnesds  Sioutale Network  SunFloor Graph  Stals  Help

Voo - ¢ 4d48<0

.E.l‘.';'ﬂ-ﬂl:?l ; e 'I T — .. ..
A ) __ Soucs [ Destnaon | BW [ ksl T  Message |
o [ Privale mermorles £ =] ] |5 1] ] |

o (] Shated marrioriaz (1)
o (23 Interruptions {£)

o= ] Semaphonas (1)

o= T Links §6)

o [ Routes (24)

&[] Switches (4)

= SunEllu_zi:_zg;e:;_mcat-en'
[ Aetications|
[ Tecnolagy
Dyies

2.5.6 View the FloorPlan

The FloorPlan is a graph generate by SunFloor that shows the structure of the net
created. You only can see it if the current network has been generated by SunFloor.

To see this graph go to SunFloor >Show floorplan

SunFloor | Graph
Show floor plan

Preferences.. F
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2.5.7 Simulate the Routes

To see the route’s paths (with all its switches and its links between them) go to
Simulate->Simulate route.

Simulate | Network !
‘Simulate route
Simulate hetwork

Compile network

Yiew System.C

Or press the simulate routes button: I_%‘
The net must have some routes to simulate them

A new window will appear where you can choose the routes of the net you want
simulate following these steps:

% Simulate Routes

hoose the routes:
core_0to pm_2 {0) i Routes:
core_0to shm_4 {1)
core_0to smm_5 ()
core_Otoint_6 (3)
core_2Z to pm_2 (4}
core_2to shim_4 {5)
core_Jto smm_5 (6)
core_Jtoint_6 (7}
core_1q to pm_3 (8)
core_1to shm_4 (9)
core_1tosmm_5 (10) Al
core 1toint 6 {11} G

Add routes Draw routes Cancel Deleie Routes

1)  First select the routes you want simulate on the left list of the new window and
press Add button.

The selected routes will be added into the right list (that is the routes list that will be
simulated)
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£ Simulate Routes

choose the routes:

core 0topm 2 {0}
core_0to shm_4 {1)
core_0to smm_5 (2)
core_Otoint 6 (3)
core_Zto pm_2 (4}
core_2Zto shm_4 (5)
core_Jto smm_5 (6)
core_Jtoint 6 (7}
core_1to pm_3 (8)
core_1to shm_4 (3
core_1tosmm_5 (10)
core 1toint 6 {(11)

-

IRnutes:
!cure_lil topm_2 (0
!cure_lil toshm_4
!cure_lil tosmim_5a
core_Ofoint & (3

Add routes

Draw routes

Cancel

Delete Routes |

2) You can delete the routes of the right list selecting them into the left list and press

Delete button.

£ Simulate Routes

hoose the routes:

core_0to pm_2 (0}
core_0to shim_4 (1)
core_0to smm_5 (2}
core_Otoint_6 {3
core_Ztopm_2 (4}
core_2 to shim_4 (5)
core_Jto smm_5 (6)
core_Jtoint_6 {7
core_1to pm_3 (8)
core_1to shm_4 (9)

| b

Routes:
core_Oto pm_2 (0
core_0to shim_4
core_Otoint & (3

q | Il | [»
core_1to smm_5 (10) U
core 1toint 6 {11) =
Add routes Draw routes Cancel 'pglq_ate__ﬂqqt_es-

3) To simulate the routes of the right list press Draw routes button. All these routes will

be simulated intfo the main window.
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File Edi View Comgonents Simubste Metwork SonFloor  Graph  Stats  Hedp

Yo 3o - e5AAS s

=3 Sswitch Simurate Routes;

| o= Y Procesenre (4)
o= 5] Privale memones (2) core_[tepra_2 {0
& [ Shared mematlzs (1) core_0 ~swilch_ 0= kD= swilth_1 - pm_2
& [ Interruptions (1)
e 5 Semaphoses {1)
&= 5] Links (8)
o~ [ Reutas {24)
o 28 Switches (4)

eore_ 0o shm_4 (1)
core 0 -gwich_0- lakl- switth_ 1 shm_4

core_01oint_ 6 (3)
core_ 0 = swiith_0 - lnkD- swifch 1 - B

Simulate Houtes

P2 {0 = {Routes 1

Co
cofe 0to

4. jeore_0topm 3 (¢
core o Smm 5 (2] tore_ 1 to shin_4 |
core_ Do int_6 {3} - vare. 0o ind_8 (3]

icore_2 bo phn_2 (4)
lcora_2 Lo shin_ 4 (5) L1
fcore_Jto sman_5 (6}
core 3 toint G (T

come_1topm_3 ()

core_110.shim. 4 (%) T
core_ 1 b0 sinm_5 (10) Wl
foore 1toint 6 (1) bd

| Addroutos || Drawrowtes || Cancel || Delete Routes |

4) You can cancel the simulation of the routes pressing Cancel button.
Even the incomplete routes can be simulated. If they have wrong connections

between switches of theirs paths the path will be showed without links between these
wrong connections.

2.5.8 View the network’s Graph

To see the network’s graph, it has to be a network opened or created.

To see it go to Graph >Show Graph.

-

On the graph you can move the nodes and doing double click in those you can see
the information about the node and modify or delete it.

Or press:
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File Edit View Components Simitate Network SunFloor Graph  Stals  Help

TeolBe - o5 Hi8e F

[ 5awitch
& [} Propcessors (4)
&= [ Private fermonies ()
o [ Ehared meenories (1)
| o ] interraptions (1)
& 2] Semaphaoras (1)
o [ Links (&)
| = £ Routes (24)
o [} Switthes (4)

XN

The network’s graph will be updated when any change in the net happens.

Switch 0

B
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To close the graph window go to Graph->Close Graph

_(ifaptr_| Stats |

Showe graph

Close graph

Or press: -ﬁ .

2.5.9 View Xpipes and AMBA Stats

When the net is compiled and simulated Xpipes and AMBA generates statistics files.

To see them first you have to compile the net and simulate it, if the net hasn’t been
compiled and simulated before.

If the simulate and compile process have been successful you could see both stats
files. And also you can see the comparison between them.

To see the AMBA stats file go to Statsi] View AMBA Stats.

Stats } Help
View AMBA Stats
Yiew Xpipes Stats

Compare Stats

To see the Xpipes stats file go to Stats View Xpipes Stats.

Stats | Help
View AMBA Stats
View Xpipes Stats

Compare Stats

To see the Comparison between them go to Stats>Compare Stats.

Stats | Help
View AMBA Stats

YView Xpipes Stats
Compare Stats

If only simulate for AMBA has been successful you only could see the AMBA stats file.
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SunF loor AMBA Stats =13
Name IMasterSystem 0y, Time(ns) | Seectimedolal | Sbusbusy |~
{Overall axec time (156410 7820500 i -
[1-CPU average &, 156304 {78197 139.96% or 156410 |-
= _Coneurrent exect. |158379 7318950 199 98% of 156410 |-
® Interconnections [Bus husy 136234 1811700 123 17% of 156374 |-
{Bys transferring .. 12213 1085.0 [7.81% 0f 156379 |33.71% o1 36234
) Processor 0
X
Bus Accesses =1 1844 (0 SR, 11722 SW, 122 BR, 0 BW: 122 R, 11722'W)
) Processor 1
[ min_
o
| |+ - 50 ]
117280 i
234500 130
117280 ;

O Interconnections

- Pfu:em 0

) Processor 1

) General

ect Accesses = [l to DMA
Imwparmhm cwcles  =11844
Total bus aciiaty cycles = 132324 (bus completion + wrapper OH)
"Free” Bus accesses = 0(0.00% of 5922}
e cycles =0 3
Bus Accesses = 5022 (0 SR, 5861 SW, 61 BR, 0 B 61 R, 5861 W)
MName Timeins) SCLESSEE Ay min
Time (ng)10.5... 4N 10
s 50
z0 10
0 20
i 10 ]
50 5
120 i B
20 28
40 ]
|&d 20
Marme e acc les
Private reads Bl 54933 -
Bus+Wirapper waits - 527
Frivate wriles 5861 5861
Bus+Wrappes walls - 29308 =
Shared reads ] L]
Bus«¥Wrapperwails - a
Shared wiites 2 0 ™
Bus+¥rapper waits - 0
|{Semaphore reads a o -
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SunFloor AMBA Stats

O Interconnections

) Processor

) Processor{ — X

i® General

If only simulate for Xpipes has been successful you only could see the Xpipes stats file.

sunkloor Xpipes Stats |Z| EFE
Narne ! ter system cycles | Timens)
; : Overall exec fime _[128 406650
® Interconnections: |3 CPU average exectime 128131 |Banes
Concurrent axec ime 128131 6308555
Mo
oM
Name | Packets E iny i
i i |8 |0
BR__ JLEE [130 s
L Buffers L iz 5] 185
EVF 1 o |0
Ll j[1] L L
BN 0 o 0

) Links Receier

OIMANES | Sk => single Read

BR => Burst Read

) Processor 0 SWP => Single Write Posted
BYWP => Burst Write Posted

O Procasanr i SWNP => Single Write Non Posted
BYWNP == Burst Write Hon Posted
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SunFloor Xpipes Stats

) Interconnections
(Onverall traffic generated by xpipes NED (atencies expressed in ns):
® N0
Hame | Packels I avag min | max

SR ] 0.00 0 0
oL ER 6t 135.00 130 158

SWP. 5861 5510 55 85_

BWE i 0.0a 0 ]

SWHP a 004 a o
O Buffers EVHP 0 U 0 B |
¥ Links Recefver

[Traffic towards xpipes target Nl 2

(2 OCP Performance

i) Mame | Packets _ aveg i | miax
~ SR 0 004 a 0

' Processor 0 L At £

SR BR 61 135,00 130 158

S {5661 j35.10 55 95

BAP_ 8 10.00 10 i
- SWNE 4 {000 o L
W FTocessor 1 BYNP 0 {0.00 0 0

= SunFloor Xpipes Stats

) Interconnections
. BufTers:

I NID
N

| WL | Total [ mmin | ran 1 aweg

(R B B el ' ] 33

i ] 0 15 033
® Buffers 2 B [0 7 {0.01

3 8 2 {0.01
) Links Recower
© 0CP Performance Bovtero  outer1  burerz  [outrers
) Processer 0 : it 8

B = e
\\\ /_r’ : “"\.
e T e =] e
! Processor 1 N
o =3




Sunfloor Xpipes Stats

xpipes link recerver D - xpipes.xpipes_ICxpswitch_0; B
! Interconnections
Port Total ] ALK | MACK | S{ACKeytles)
: 0 5 0] o 0.00%
N0 1 B 8 o [Do0%
Fl B 0] [o 10.00%
3 B 0 [0 [0.00%
4 5 0 [0 0.00%
NI
spipes link receher 1 .- kpipesapipes_ICapswitch_1:
) BulTers
: Port Total ACK | NACK | %(ACKcycles) |
® Links Recerver | |0 5 ] 12 10.00%
1 5 ] (o 000%
2 5 0 2 10.00%
3 5 0 1o 0.00%
© oCP Performance | 5. ] o [0.00%
) Processor 0 xpipes link receiver 2 - Rpipes.spipes_iCxpswitch_2:
' Processor 1  Pot | Tolat | AGK | NAGK | S(ACKicytles)
0 S 0] o 10.00%
1 &5 [a f 10.00% =
= o Ta Ta Ta AR et

SunFloor Xpipes Stats

| O terconnections
:_OCPMCF}SSBE = 11844 (0 SR, 122 BR, 11722 SWP, 0 BWP, 0 SWNP, D BWHP: 122 R, 1
| M
o Marneg | Actesses Total accesses | max averg _
[i= Tirne {ne) to.crd... 1930 122 130 754 5
Time {ns) tatast .. (18000 122 [185 147.54 [
Tirme (ns) to cmg._ (58700 11722 g 501 5
[ Tirme (ns) to cmd. . 920 122 130 754 15
| O Buffers Time {ns) to fast .1 8600 122 185 14754 1
| Tirne (ns) tocmd.. [S8700 11722 o 5.1 5
| 2 Links Receiver
| ® OCP Performance| | SR = Sinle Read
BR => Burst Read
I SWD => Single Write Posted
| C Processor 0
BWP => Burst Write Posted
[ SWHP => Single Write Non Posted
| L Processor 1 | 3
| | BWWHP == Burst Wirite Hon Posted =
! Kl i I
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= Sunfloor Xpipes Stats

[Processor 0 bt
O Interconnections ]
Direct Accesses =010 DMA
Mo
hile cycles -
(o) B = —
e ace = = tyeles
(61 (9485
 Buffers [Private wiites _|5861 5
Bus+Weapper waits = 3
\Shared reads 0 g
Bua'mapparwauis_ - o
A 5 Shared writes [i] 0
ot L T ithr Bus +Wrapper wails - o
|Semaphore reads. o i
Bus+Wrapper waits = 0
- Semaphore wiltes 0 0 =]
(S OCP Performance [Bus+wWrapper waits 0
® Processor 0
Info Cache
) Processor 1
=
i i [ I+

In the Stats Comparison you can selected the rows you what compare and press
View graph button to see the rows in a graph.

Sunkloor Compare Stals

B B! [overan Ere_tj,hla'sg Jreaall axec{Time: ICPUm'@g;gmar: [ 1-CPUI gvery I l:nn-:uren[mtg;y Cﬁntmemaxﬂtﬂ‘
1 .T 55410 2 ?EEEHH.E 15635 - :.?3137" : |1 56379 [TegEs 0
Hpipes li28131 [64tE55 0 26151 (64085 EEEET] lG4tg550
WView Graphs
|_SRinag. '. SR | srimin | BRme) | BR[| BR(min | &Mn:maxL SWiavy) | wﬂ;mm:
ANBA 50 55 2001 {0 18D 5742 ;
plpes |u ¢ DI:I o 152 112500 130 s ECR T _ss
1
| Wiew Graphs |
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¢ SunFloor Compare Stats

= rverall exeeiMast, Overal srec{Time, |1-CPLU averg exec, |1-CPU averg ee., [Concurent exe (. [Concurent exee(T

:_ﬁ:Hgiﬂ- 156410 jFE ?u_s,n 1] 1156394 rear i EB3TY TE18950

Hplpes 128131 {EADE55.0 RFEE] 54065 {12813 G40655.0

Wiew Graphs

| | &Rimag | Shiavg | SR(mim) | BR(may | BRiwg | BR{min} | SWimas) | S iwg; | S imin |
AWEA (@0 L A ) 5 .@ﬂlﬂ.p _ G2 jBzaz 0

Hplpes ll:l 08 _!_ﬂ 1155 113500 130 185 (5510 155

| View Giaphs_|

Bamea [ xpipes

2.6 Compile and Simulate the network

To compile and simulate the net, it is necessary to have an opened or created net in
NoCdificador.

First compile the net, going to Simulate>Compile Network.

Simulate | Metwork !

Simulate route

Simulate network
 Compile network

Wiew System.C

The results of the compile will be showed in the main window. You can see if any error
has happened compiling the net in the results.

If the net has been compiled successful then you can simulate it. But if it has had
error compiling the net you can see them in the main window but you can’t simulate
it.
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To simulate the net go to Simulate->Simulate Network. It asks you for a number of
initiators and a type of simulation.

\Qﬁﬂulﬂia | Network
Simulate route
Simulate network
.C[.Imﬁile n;ﬁw;n.;nrk
View System.C

You must give a number of initiators and a type of application:

Mumber of initiators

#y | How many initiators?
il

Aceptar Cancelar
Application [E|
Select an application
asm-matrixing =
Aceptar Cancelar

There are more application types:

Application

X

Select an application
asm-matrizind i~
asm-matrixind

el A ST LU VTR el
asm-gsort
asm-supporttest

This action simulates the net with Xpipes Compiler and AMBA. This process can take a
long time, depends on the simulation type.

When the simulation is finished the results are showed in the main window. Even if the
simulations haven't successful you can see the errors in the results.

You can see the systemC file generated going fo Simulate-> View SystemC
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Simulate | Network

Simulate route
Simulate network
Compile network
View System.C

If the one or both simulations have successful you can see the Stafts files generated
by Xpipes and AMBA too, going to Stats menu.

7

You can do both actions pressing the Button: | I that compile and then simulate
the network.

2.7 Save a network

When you want to save the net you can save it with the save name if it has one
because of it was opened before, or you can save it with another name.

To save the net with the same name it had go fo File>Save. Or press the save

d

Buffon |

'File| Edit View

Hew
Open network
Close

Save as...

Exit

If the net wasn’'t opened and it hasn't a save name yet, It ask you for a name to save
the network txt file.

To save the net with another name (not with the name that has when it was opened)
go to File>Save cs...

File | Edit View

Hew
Open network
Close

Save

Bave as...

Exit
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2.8 Close a network

When you want to close a network go to File>Close.

ﬁle| Edit View

Hew
Open network

Save

Save as...

Exit

If the netisn’t saved yet NoCdificador asks you for save it. When the current net is
closed its network tree disappears too.

% MNoCdificator

File Bt View Conjho

2 @@_}--E % 9@

k SunFloor Graph State  Help
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3. DESCRIPTION OF THE CLASSES

NoCdificador is composed by 65 classes, which are divided in three groups:

Parse Classes:

Parse
Parse_Stats
Parse_Stats2

Graphic Classes:

ModifyNoC
Principal

» To modify
ComponentChooser
CoreMenu
CoreMenuMod
LinkMenu
SwMenu
RouteMenu
SunFloorMenu
NewNetWindow

» To view information
ChooseRoutes
CorelnforWindow
LinkInforWindow
RoutelnforWindow
SwinforWindow
StatsWindow
StatsWindow?2
StatsWindowCompare
Grafo
Help
Principal_AboutBox
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Logic Classes:

For the net and its structure

Network
Component
Core
PrivateMemory
Semaphore
SharedMemory
Switches

Route

Interrupt

Link

Branch

Tree
TreeSunfloor
ComponentPositionPair
Save

To undo and redo modifications

Modification
Change

For parse classes

TXTFilter
ParseReturnPar
XMLFilter

For the tables of the program

Datos
LinkReceiverElement
ModeloTabla
ModeloTablaStats
ModeloTablaStats2
NI_Element
ObjetoTabla0
ObjetoTablal
ObjetoTabla?2
ObjetoTabla3
ObjetoTabla4
ObjetoTablab
ObjetoTablaé
ObjetoTabla7
processor_stats
processor_stats2
SWARM_processor
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» To syncronize the threads
Consumidor

Productor
Tuberia

ModifyNoC is the main class of the project and Principal is the interface of it. Now, we are
going to detail each class:
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ModifyNoC

This is the main class; its function is fo create the main window.
Aftributes:

Principal p

Methods:

Main: creates a new Principal object

Principal

This is the class that represents the main window. This class takes the control of the user
actions and enable or disable buttons and options of the Menu Bar.

Attributes:

Int startOption

JPane contentPane
JMenuBar jMenuBarl
JPanel jPanell

JPanel jPanel2

Int nuMSF

Help help

SunFloorMenu sunNuevo;
Parse parse

Save save

Network net

String saveName
ComponentChooser chCompo
Vector drawRoutes
Thread my_thread
Grafo g

Parse_Stats pa_Stats
Parse_Stats2 pa_Statfs2
Tree jTreel

TreeSunfloor jTreeSunfloor
int xcoOK

int cplOKwithAMBA

int cplOKwithXpipes

int sunfloorOK
booleanisYetSave

Methods:

Main: creates a new Principal object
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Branch

This class represents a branch of the net tree.
Aftributes:

DefaultMutableTreeNode n

Methods:

Branch( Vector facts )

Change

This class represents one or more modifications in the net.
Aftributes:

Vector whatModifications

Methods:

Change|)

Vector getModifications|)
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ChooseRoutes
Window to choose the routes to be simulated.
Aftributes:
Principal p
Methods:
ChooseRoutes(Principal p)
boolean esta(String s):
Returns true if the selected route is in the right list, else returns false.
addButton_actionPerformed(ActionEvent e):

This function adds a new selected route from the left list in the right list, if the
selected route or routes are in the right list, they won't be added again.

drawButton_actionPerformed(ActionEvent e):

This function draws the routes of the right list info the main window. Routes are
drawed with all its switches and links.

cancelButton_actionPerformed(ActionEvent e):
This function removes all the routes of the right list and closes the window.
deleteButton_actionPerformed(ActionEvent e):

This function deletes the selected route of the left list in the right list, if the selected
route or routes aren't in the right list, they won't be deleted again.

deleteAllButton_actionPerformed(ActionEvent e):

This function removes all the routes of the right list.
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Component

This class represents any network's element
Attributes:

String name

String prefix

String componentTypeName
boolean incompleted
Methods:

Component|()
setName(String s)

String getName()

boolean getincompleted|)

setincompleted(boolean b)

Grafo

Show the net with a graph window.

Attributes:

List selection

Principal p

Network n

Methods:

Grafo(Principal p_aux, Network n_aux):
Create the graph from the network

run()

chooseElement(List lista):

Open the correspondent information window of the element selected.
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ComponentChooser
This class is a window to choose a type of network’s element
Attributes:

Network r
Principal p

Methods:
ComponentChooser(int actionType,Principal p):

Action type is 0 to create a new component, 1 to modify an existing component or
2 to delete an existing component.

acceptButton_actionPerformed(ActionEvent e):

Open the correspondent window for each action type, where coreType is O for a
core, 1 for a pm, 2 for a shm, 3 for a smm, 4 for an interrupt.

Cases:
. New core, pm, shm, smm, int => new CoreMenu(coreType,p);
. Modify core, pm, shm, smm, int => new CoreMenuMod(coreType,1,-1,p);
. Delete core, pm, shm, smm, int => new CoreMenuMod(coreType,2,-1,p);
. New switch => new SwMenu(0,-1,p);
. Modify switch => new SwMenu(1,-1,p);
. Delete switch => new SwMenu(2,-1,p);
. New link => new LinkMenu(0,-1,p);
. Modify link => new LinkMenu(1,-1,p);
. Delete link => new LinkMenu(2,-1,p);
. New route => new RouteMenu(0,-1,p);
. Modify route => new RouteMenu(1,-1,p);
. Delete route => new RouteMenu(2,-1,p);

cancelButton_actionPerformed(ActionEvent e):
Close the window
ShowWarnningMessage() :

If there is any problem, show the warning message
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ComponentPositionPair
This class is used to look for components in the net.
Attributes:

int position
Component object

Methods:
ComponentPositionPair()
setPosition(int i)

int getPosition()
setComponent(Component o)

Component getComponent|)

Consumidor
Aftributes:

Tuberia tuberia
Methods:
Consumidor(Tuberia 1)

void run()
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Core
It's a processor of the network
Attributes:

String sw

double divFrec
int numBuUf

String args

String argé

String corePrefix
boolean bi

int inputBufDepth

Methods:
Core(String i1, String i2, double d3, int i4,String a5, String aé.int inputBufDepth)

Core(String i1, String 2, double d3, int i4,String a5, String aé,boolean bidir,int
inputBufDepth)

setSwitch(String i)
String getSwitch()

setDivFrec(double i)
double getDivFrec|)

setNumBuUf(int i)
int getNumBuUf()

setArg5(String s)
String getArg5()

setArgé(String s)
String getArgé()

setincompleted(boolean b )
boolean getincompleted|)

boolean isBi)
setBi(boolean bi)

int getinputBufDepth()
setinputBufDepth(int inputBufDepth)
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CorelnforWindow
Show the properties of a core modify it or delete it.
Attributes:

Networkr;
Principal p;

Methods:
CorelnforWindow (int type,String nom,Principal p)
Vector giveMeRoutes(int coeNumber, int type):

Returns a Vector of routes in which the core appears.
acceptButton_actionPerformed(ActionEvent e):

Close the window.
modifyButton_actionPerformed(ActionEvent e):

Close the window and show a new window to modify the core => new
CoreMenuMod(typeC,1,number,p,this);

deleteButton_actionPerformed(ActionEvent e):

Close the window and show a new window fo delete the core =>new
CoreMenuMod(typeC,2,number,p,this);

81



CoreMenu
It is a window to create a core, private memory, shared memory, semaphore, or interrupt.
Attributes:

Networkr;
Principal p;

Methods:
CoreMenu(int n,Principal p) :

Where coreType is: 0->Core, 1->PrivMem, 2->ShaMem, 3->Semap, 4->Int.
cancelButton_actionPerformed(ActionEvent e):

Close the window.
acceptButton_actionPerformed(ActionEvent e):

Make sure that all the attributes are correct and create the new element.
int value(char(] a):

Returns the int value of a char array of digits
double valorDouble(char(] a) :

Returns the double value of a char array of digits
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CoreMenuMod
It is the window to modify or delete a core, pm, shm, smm or int.
Attributes:

Networkr;
Principal p;

Methods:
CoreMenuMod(int n, int action, int direct,Principal p):
Where coreType is: 0->Core, 1->PrivMem, 2->ShaMem, 3->Semap, 4->Int;
actionType is: 1->modify or 2->delete; directOption is -1 if anyone is modified,if nof,
the number of the component to be modified (clicking)
cancelButton_actionPerformed(ActionEvent e):
Close the window.
acceptButton_actionPerformed(ActionEvent e):
Make sure all the attributes are correct and modify or delete the new element.
double doubleValue(char(] a) :
Returns the double value of a char array of digifs.
int value(char(] a):
Returns the int value of a char array of digits
properties():

Show the properties of the element selected
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Datos

This is the structure of each row of the SunFloor tables.
Attributes:

String s1

String s2

String s3

String s4

String s5

Methods:

Datos(String s1,String s2, String s3, String s4, String s5)

Datos(String s1,String s2, String s3)

String get1()
String get2()
String get3()
String get4()

String get5()

setl(String s)
set2(String s)
set3(String s)
set4(String s)

set5(String s)



Help
Shows an html manual to help the user.
Attributes:

long serialVersionUID
JEditorPane panel

Methods:
Help()
change(URL url):
It changes the webpage. This will be invoked when a link is clicked.
addHyperlinkListener(HyperlinkListener listener):

Add a hyperlink to attend the events of click in a link.

Modification

This class represents modifications in any element of the net.
Attributes:

Network r

int actionType : (O->create, 1->modify, 2->delete)

int list

int pos

Component componentModify

Methods:

Modification()
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Interrupt

This class represents an interrupt element in the net.
Attributes:

String sw

double divFrec

int numBuUf

String args

final String preArgé
String posMem
boolean fixed
String CorePrefix
boolean bi

int inputBufDepth

Methods:

Interrupt(String i1, String i2, double d3, int i4,String a5,String i6, boolean b7,int inputBufDepth
)

Interrupt(String i1, String i2, double d3, int i4,String a5,String i6, boolean b7,boolean bidir,int
inputBufDepth)

setPosMem(String i)

String getPosMem()
setFixed(boolean b)
boolean getFixed()
setSwitch(String i)

String getSwitch()
setDivFrec(double i)

double getDivFrec|)
setNumBuUf(int i)

int getNumBuUf()
setArg5(String s)

String getArg5()
setincompleted(boolean b )
boolean getincompleted|)
boolean isBi)

setBi(boolean bi)

int getinputBufDepth()
setinputBufDepth(int inputBufDepth)
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Link

This class represents a link element of the network.
Attributes:

String source

String target

boolean bidirectional

int numRepeaters

Methods:

Link(String i1, String i2, String i3, int i4)

Link(String i1, String i2, String i3,boolean bidir,int i4)

setSource(String i)
String getSource()

setTarget(String i)
String getTarget|()

setfincompleted(boolean b )
boolean getincompleted|)

setBidir(boolean b )
boolean getBidir()

int getNumRepeaters()
setNumRepeaters(int numRepeaters)
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LinkinforWindow
Shows the properties of a link modify or delete it.
Attributes:

Network r
Principal p

Methods:
LinkInforWindow (String nom,Principal p)
String[] readOnlySwitchName (String n) :

Returns the switch name, and the subchannel in the second position.
Vector giveMeRoutes(int n):

Returns a Vector of routes in which the core appears.
acceptButton_actionPerformed(ActionEvent e):

Close the window.
modifyButton_actionPerformed(ActionEvent e):

Close the window and show a new window to modify the link => new
LinkMenu(1,number,p,this);

deleteButton_actionPerformed(ActionEvent e):

Close the window and show a new window to delete the link => new
LinkMenu(2,number,p,this);
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LinkMenu
Window that Create modify or delete a link.
Attributes:

Principal p
Network r

Methods:
LinkMenu(int n, int direct,Principal p)
CancelButton_actionPerformed(ActionEvent e):
Close the window.
acceptButton_actionPerformed(ActionEvent e):
Make sure all the attributes are correct and modify or delete the new element.
int value(charl] a):
Returns the int value of a char array of digits.
properties():

Show the properties of the element selected.

LinkReceiverElement
It is a LinkReceiver element of Xpipes Stats.
Attributes:

Vector tab1
String label

Methods:

LinkReceiverElement(String |, Vector tab1)
String getLabel()

void setLabel(String |)

Vector getTabl|)
void setTab1(Vector tabl)
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ModeloTabla

It represents the structure of the SunFloor Table.
Attributes:

int tipo

LinkedList datos

LinkedList listeners

Methods:

sefTipo(int i)
int getTipo():

int getColumnCount():Returns the number of columns in the table

setDatos(LinkedList list) : Insert the dates in the table
LinkedList getDatos(): Returns the dates in the table

Object getValueAt(int rowlndex, int columnindex):
Returns the value for the cell at <code>columnindex</code>
<code>rowlndex</code>.
deleteRow (int r): Remove the row r of the table.
addDato(Datos newRow): Add a new row r into the table.
addTableModellistener(TableModellistener I): Add a listener in the table.
Class getColumnClass(int columnindex):

Returns he class of the elements of the column ¢

String getColumnName (int columnindex):
Returns the name of the column at <code>columnindex</code>.

boolean isCellEditable (int rowlndex, int columnindex)
removeTableModellistener(TableModellListener )
setValueAt(Object aValue, int rowlndex, int columnindex)

avisaSuscriptores (TableModelEvent evento)
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ModeloTablaStats

It represents the structure of the AMBA Stats Table
Attributes:

int tipo

LinkedList datos

LinkedList listeners

Methods:

setTipo(int i)
int getTipo():

int getColumnCount():Returns the number of columns in the table

setDatos(LinkedList list) : Insert the dates in the table
LinkedList getDatos(): Returns the dates in the table

Object getValueAt(int rowlndex, int columnindex):
Returns the value for the cell at <code>columnindex</code>
<code>rowlndex</code>.

deleteRow (intr): Remove the row r of the table.

addDato(ObjetoTablal newRow)

addDato(ObjetoTabla2 newRow)

addDato(ObjetoTabla3 newRow)

addDato(ObjetoTabla4 newRow)

addDato(ObjetoTabla7 newRow)

addTableModellistener(TableModellistener I): Add a listener in the table.

Class getColumnClass(int columnindex):
Returns he class of the elements of the column ¢

String getColumnName(int columnindex):
Returns the name of the column at <code>columnindex</code>.

boolean isCellEditable(int rowlndex, int columnindex)
removeTableModellistener(TableModellistener )
setValueAt(Object aValue, int rowlndex, int columnindex)

avisaSuscriptores (TableModelEvent evento)
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ModeloTablaStats2

It represents the structure of the Xpipes Stats Table
Attributes:

int tipo

LinkedList datos

LinkedList listeners

Methods:

sefTipo(int i)
int getTipo():

int getColumnCount():Returns the number of columns in the table

setDatos(LinkedList list) : Insert the dates in the table
LinkedList getDatos(): Returns the dates in the table

Object getValueAt(int rowlndex, int columnindex)

deleteRow (int r): Remove the row r of the table.

addDato(ObjetoTabla0 newRow)

addDato(ObjetoTablal newRow)

addDato(ObjetoTabla2 newRow)

addDato(ObjetoTabla3 newRow)

addDato(ObjetoTablas newRow)

addDato(ObjetoTablaé newRow)
addTableModellistener(TableModellistener I): Add a listener in the table.

Class getColumnClass(int columnindex):
Returns he class of the elements of the column c

String getColumnName(int columnindex):
Returns the name of the column at <code>columnindex</code>.

boolean isCellEditable(int rowlndex, int columnindex)
removeTableModellistener(TableModellistener )
setValueAt(Object aValue, int rowlndex, int columnindex)

avisaSuscriptores (TableModelEvent evento)
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Network
This class is the net. The net has all the component lists and can modify them.
Attributes:

String name

int topologyType; 0->OTHERS , 1->MESH , 2->TORUS
Changel] undo

int undoSize

Changel] redo

int redoSize

int numCreatedRoutes
Vector coreslList

Vector privateMemsList
Vector sharedMemslList
Vector semaphoreslList
Vector interrupftsList
Vector switcheslList
Vector linksList

Vector routeslList

Methods:

addSwitchtoCore(int coreType,String CoreName,String swName)
conneSwitchesNet ()

createNet(int wide,int high.int type,int inputs,int outputs, int buffers)
Network deleteNet|)

deleteUncompletedCores|)

deleteUncompletedinterrupts()

deleteUncompletedLinks()

deleteUncompletedPMem()

deleteUncompletedRoutes|)
deleteUncompletedSemaphores()
deleteUncompletedSMem()

deleteUncompletedSwitches()

emptyRedo()

Modification executeModify(int i1, int i2, int i3, Component c4)
Boolean exist(String n,int list)

Core extractFromCorelist(int i)

Interrupt extractFrominterruptList(int i)

Link extractFromLinksList(int i)

PrivateMemory extractFromPrivateMemoryList(int i)

Route extractFromRoutesList(int i)

Semaphore extractFromSemaphoresList(int i)

SharedMemory extractFromSharedMemoryList(int i)

Switches extractFromSwitchesList(int i)

Change extractRedo()

Change extractUndo()

ComponentPositionPair findElement(String name, int list)
Modification getinverse(intil, inti2, int i3, Component c4)
String getName()

setName(String s)
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sefTopologyType(int i)

int getTopologyType()

setNumCreatedRoutes(int c)

int getNumCreatedRoutes|()

static Network getNet|()

static Network getNet(String nam, int type)

boolean insertRedo(Change m)

boolean insertUndo(Change m)

boolean modifyCore(int actionType,int Pos,String i1, String i2, double d3, int i4,String a$,
String aé,boolean bidir,int inBuf, Change c¢)

boolean modifylnt(int actionType,int Pos,String i1,String i2, double d3, int i4, String a5,String
i6,boolean b7,boolean bidir,int inBuf, Change c)

boolean modifyLink(int actionType,int Pos,String i1, String i2, String i3,boolean isbidir,int
inBuf,Change c)

boolean modifyNet(String n)

boolean modifyPrivMem(int actionType,int Pos,String i1, String i2, double d3, int i4, String
ab,String i6,boolean b7,boolean bidir,int inBuf, Change ¢)

boolean modifyRoute(int actionType,int Pos,String i1, String i2, int sType, int dType, Vector
v3,3tring name)

boolean modifyShMem(int actionType,int Pos,String i1, String i2, double d3, int i4, String
ab,String i6,boolean b7,boolean bidir,int inBuf, Change c¢)

boolean modifySmm(int actionType,int Pos,String i1, String i2, double d3, int i4, String
ab,String i6,boolean b7,boolean bidir,int inBuf, Change ¢)

boolean modifySw(int actionType,int Pos,String il, int i2, int i3, int i4,int inBuf,Vector
Channels, Change c)

boolean modifySw(int actionType,int Pos,String i1, int i2, int i3, int i4,int X, int Y, int
inBuf,Vector Channels,Change c)

boolean routeCompleted(int i)

boolean hasSubChannel(String swName, String subcha)
String linkBetween(String a, String b)
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NewNetWindow
This is the window to create a new net.
Attributes:

Principal pr
Network net

Methods:
NewNetWindow (Principal p)

ShowTextFields():

Depends on the topology type It will be necessary to fill more or less gap.

int value(char(] a):

Returns the int value of a char array of digits.
jButton1_actionPerformed(ActionEvent e):

Accept Button: Check the correct attributes and creates the new net.
jButton2_actionPerformed(ActionEvent e):

Close the window.
jComboBox1_actionPerformed(ActionEvent e):

Show the correct gaps when the selected element
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NI_Element

This represents a network interface element of Xpipes Stats
Attributes:

Vector tabGenBy

String labelGen

Vector labelTowards

Vector TowardsTabs

Methods:

NI_Element(String |, Vector tab1, Vector labelsT, Vector tabs)

String getlLabelGen|)
setLabelGen(String |)

Vector getTabGen|)
setfTabGen(Vector tab1)

Vector getLabelTowards()
setLabelTowards(Vector labelTowards)

Vector getTowardsTabs()
setTowardsTabs(Vector tfowardsTabs)
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ObjetoTabla0

This is the structure of a row of the Interconnect AMBA

Attributes:

String name
String auxl
String aux2
String aux3
String aux4

Methods:
ObjetoTabla0(String

String getAux1()
setAux1 (String aux1)

String getAux2
setAux2(String aux2)

String getAux3()
setAux3(String aux3)

String getAux4()
setAux4(String aux4)

String getName()
setName (String name)

s,

String

52,
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ObjetoTabla1

This is the structure of a row of the Interconnect statistics 1 table.

Attributes:

String name
String auxl
String aux2
String aux3
String aux4

Methods:
ObjetoTablal(String

String getAux1()
setAux1 (String aux1)

String getAux2
setAux2(String aux2)

String getAux3()
setAux3(String aux3)

String getAux4()
setAux4(String aux4)

String getName()
setName (String name)

s,

String

52,
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String

s3,

String

54,

String

s5)



ObjetoTabla2

This is the structure of a row of the interconnect statistics 2nd tables.

Attributes:

String name
String auxl
String aux2
String aux3
String aux4
String auxs

Methods:
ObjetoTabla2(String

String getAuxl|()
setAux1 (String aux1)

String getAux2
setAux2(String aux2)

String getAux3()
setAux3(String aux3)

String getAux4()
setAux4(String aux4)

String getAux5()
setAux4(String auxb)

String getName()
setName (String name)

sT,

String

52,

String
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54,

String

s5,

String
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ObjetoTabla3

This is the structure of a row of the SWARM Processor table.
Attributes:

String name

String auxl

String aux2

Methods:

ObjetoTabla3(String s1, String s2, String s3)

String getAuxl|()
setAuxl (String auxl)

String getAux2
setAux2(String aux?2)

String getName()
setName(String name)
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ObjetoTabla4

This is the structure of a row of the general statistics table.
Attributes:

String name

String auxl

String aux2

String aux3

String aux4

String auxs
String auxé

Methods:

ObjetoTabla4(String s1, String s2, String s3, String s4, String s5, String sé, String s7)

String getAuxl|()
setAuxl (String auxl)

String getAux2
setAux2(String aux?2)

String getAux3()
setAux3(String aux3)

String getAux4()
setAux4(String aux4)

String getAux5()
setAux4(String auxb)

String getAuxé()
setAux4(String auxé)

String getName()
setName (String name)
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ObjetoTabla5

This is the structure of a row of the buffers table.

Attributes:

String name
String auxl
String aux2
String aux3
String aux4

Methods:
ObjetoTabla5(String

String getAux1()
setAux1 (String aux1)

String getAux2
setAux2(String aux2)

String getAux3()
setAux3(String aux3)

String getAux4()
setAux4(String aux4)

String getAux5()
setAux4(String auxb)

String getName()
setName(String name)

sT,

String

52,

String
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ObjetoTablaé

This is the structure of a row of the Xpipes Stats Interconnect table.
Attributes:

String name

String aux

String aux2

Methods:

ObjetoTablaé(String s1, String 52, String s3)

String getAuxl|()
setAux1 (String aux1)

String getAux2
setAux2(String aux?2)

String getName()
setName(String name)
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ObjetoTabla7
This is the structure of a row of the Second Compare statistics table.
Attributes:

String name
String auxl
String aux2
String aux3
String aux4
String auxs
String auxé
String aux7
String aux8
String aux?

Methods:

ObjetoTabla7(String s1, String s2, String s3, String s4, String s5, String sé, String s7, String s8,
String s9, String s10)

String getAuxl|()
setAux1 (String aux1)
String getAux2
setAux2(String aux2)
String getAux3()
setAux3(String aux3)
String getAux4()
setAux4(String aux4)
String getAux5()
setAux4(String auxb)
String getAux4()
setAux4(String auxé)
String getAux7()
setAux4(String aux?)
String getAux8()
setAux4(String aux8)
String getAux?()
setAux4(String aux?)
String getName()
setName(String name)
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Parse
This class analyses the network TXT file for open the net.
Attributes:
Network net
int end
int barNumber
LineNumberReader input
BufferedWriter advise
Principal p
Methods:
Parse(Principal p)
analyse(String a):
This method returns an integer that indicates what component is being reading.

int createCore():

Create a core, pm, shm, smm or int component. It returns 0 if the component was
created or 1 if not.

int createCore?2|):

Read a core sentence and create the core. It returns O if the component was
created or 1 if not.

int createlnterrupt():

Read an interrupt sentence and create the interrupt. It returns 0 if the component
was created or 1 if not.

int createlink():

Read a linkj sentence and create the linkj. It returns O if the component was
created or 1 if not.

int createPrivateMem():

Read a private memory sentence and create the pm. It returns 0 if the component
was created or 1 if not.

int createRoute():

Read a route sentence and create the route. It returns 0 if the component was
created or 1 if not.

int createSemaphore():
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Read a semaphore sentence and create the smm. It returns O if the component
was created or 1 if not.

int createSharedMem():

Read a shared memory sentence and create the shm. It returns 0 if the component
was created or 1 if not.

int createSwitch():

Read a switch sentence and create the switch. If returns 0 if the component was
created or 1 if not.

boolean createTopology():

Read a topology sentence and create it. It returns true if the topology was created
or false if not.

double doubleValue(char[] a)
int value(char[] a)

ParseReturnPar readFile():

This method opens the file the user has chosen and interprets it.
ParseReturnPar readFile (String route):

This method opens the file of the route the user has chosen and interprets it.
String readNameWord():

This method reads words of the file which are names of components.
String readWord():

This method reads words of the file and returns them.

int whatCoreType (String tipo)
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Parse_Stats
This class analyse the AMBA stats TXT file.
Attributes:

String file

Vector infroduction

Vector intferconnectionsTable1
String interconnectionsLabel
Vector interconnectionsTable2
Vector processors

Vector generalTable

Vector general

Vectorinterl

Vector inter2

String interLabel

Vector pTablel

Vector pTable2

Vector procs

Methods:
Parse_Stats()

double doubleValue(char(] a)
int value(char(] a)

fleToVectors():

Obtain the vectors to fill the statistics tables.
fillTheGaps():

Obtain the values of the empty cells of each table.
boolean p_interTablela(int i)
boolean p_interTable1b(int i)
boolean p_interTablelc(int i)

boolean p_interTable2(int position)

boolean processorTablel (int position, Vector v)
boolean processorTable2(int position, Vector v)

String pTableGeneral(String label)
readFile()
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Parse_Stats2

This class analyse the Xpipes stats file.
Attributes:

String file

Vector infroduction

Vector Intl

Vector Int2

Vector Nls

Vector Buffers

Vector LinkR

String OCPLabel

Vector OCPTable

Vector Procs

Methods:

Parse_Stats2()
fleToVectors()
p_BufTable(Vector v)
boolean p_interTable1(int i)
Vector p_interTable2(Vector v, int i)
p_linkTable(Vector v)
p_NITable(Vector v)
p_OCPTable(Vector v)
p_procsTable(Vector v)

ObjetoTabla3 processorTable_aux(int position, Vector v)

readFile()
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Principal_AboutBox
This is the credits window
Attributes:

String product

String version

String copyright

String comments
Methods:

Principal_AboutBox(Frame parent)

actionPerformed(ActionEvent e):

Close the dialog on a button event.
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PrivateMemory
This class represents a pm element of the network.
Attributes:

String sw

double divFrec

int numBuUf

String args

final String preArgé
String posMem
String CorePrefix
boolean bi

int inputBufDepth

Methods:

PrivateMemory(String i1, String i2, double d3, int i4,String a5,String 6, boolean b7.int
inputBufDepth )

PrivateMemory (String i1, String i2, double d3, int i4,String a5,String i6, boolean b7,boolean
bidir,int inputBufDepth)

setPosMem(String i)

String getPosMem()
setSwitch(String i)

String getSwitch()
setDivFrec(double i)

double getDivFrec|)
setNumBuUf(int i)

int getNumBuUf|()
setArg5(String s)

String getArg5()
setfincompleted(boolean b )
boolean getfincompleted()
boolean isBi)

setBi(boolean bi)

int getinputBufDepth()
setinputBufDepth(int inputBufDepth)
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processor_stats
This is the structure of any row in the general table of Stats.
Attributes:

Vector tabl
Vector tab2
String labelbus
String[] infolabels
Vector infoCache

Methods:

processor_stats(Vector cache, String labelbus, String(] labels, Vector tab1, Vector tab?2)
Vector getinfoCache()
setinfoCache(Vector infoCache)
String getlLabelbus()
setLabelbus(String labelbus)
String[] getLabels|)
setLabels(String[] labels)

Vector getTabl()

sefTab1(Vector tab1)

Vector getTab?2()

sefTab2(Vector tab?2)

processor_stats2
This class represents any row of processor table of Xpipes Stats.
Attributes:

Vector tabl
String[] infolabels
Vector infoCache

Methods:

processor_stats2(Vector cache, String[] labels, Vector tab1)
Vector getinfoCache()

setinfoCache(Vector infoCache)

String[] getLabels()

setLabels(String[] labels)

Vector getTabl()

sefTab1(Vector tab1)
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Productor
This class is used by the Tube for synchronize the threads.
Attributes:

Tuberia tuberia
char ch

Methods:
Productor( Tuberia t, char cha)

run()

Tuberia
This is the tube that synchronizes the threads.
Attributes:
char buffer(]
int siguiente
boolean estallena
boolean estaVacia
Methods:
Tuberia()
boolean isEstallena():
Returns true if the tube is full.

setEstallena(boolean estallena)

boolean iskEstaVacia():

If the tube is empty or full puts this variable = true or false.

synchronized char recoger():

Method that catches letters of the buffer (like a consumer)

synchronized void lanzar(

Method that puts letters intfo the buffer (like a productor)
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Route
This class represents a path between two elements of the network.
Attributes:

String source

String target

int sourceType (0 ->core_, 1->pm_, 2->shm_, 3->smm_, 4->int_)
int targetType (0 ->core_, 1->pm_, 2->shm_, 3->smm_, 4->int_)
Vector switchesList

String stringName

boolean incompletedlist

Network net

Methods:

Route(String i1, String i2,int tipo1, int tipo2, Vector v3)
Route(String i1, String i2,int tipo1, int tipo2, Vector v3,String n)

boolean getincompleted()
setincompleted(boolean b )
setfincompletedlList(boolean b )

boolean getincompletedList()

String getNamesString ()
setNameString (String s, String d, int stype, int dtype)

String getSource()
setSource(String i)

int getSourceType()
setSourceType(int i)

String getTarget|()
setTarget(String i)

int getTargetType()
setTargetType(int i)

Vector getVector()
setVector(Vector v)
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RoutelnforWindow
This class shows the attributes of the route.
Attributes:

Network net
Principal p

Methods:
RoutelnforWindow (String nam,Principal p)
Vector giveMelinks(int n):
Returns a  Vector of links that appear in
JComponent makeTextPanel(String text):
Fill the panels
acceptButton_actionPerformed(ActionEvent e):
Close the window.

deleteButton_actionPerformed(ActionEvent

the route n".

e):

Close the window and show a new window to delete the link => new

LinkMenu(2,number,p,this)

modifyButton_actionPerformed(ActionEvent e):

Close the window and show a new window to modify the link => new

LinkMenu(1,number,p,this)

String[] readOnlySwitchName (String n):

Retuns the switch name , and the subchannel in the second position.
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RouteMenu
This window allows create, modify or delete a route.
Attributes:

Network r
Principal p

Methods:
RouteMenu(int n, int direct, Principal p)

Vector
Returns a string with the chain of the route (switches)

String write(Vector
Returns a string with the chain of the route(switches)

Vector analice(char(]

Returns a vector with the switches list like this: 0-1-2-...

int value(char[] a)
acceptButton_actionPerformed(ActionEvent e)
AddButton_actionPerformed(ActionEvent e)
cancelButton_actionPerformed(ActionEvent e)
DeleteAllButton_actionPerformed(ActionEvent e)
DeleteButton_actionPerformed(ActionEvent e)
ModifyButton_actionPerformed(ActionEvent e)
properties|)

String[] readOnlySwitchName (String n):

Retuns the switch name , and the subchannel in the second position.

Object(] routeValue(String

readList() :

n):

Returns an integer 2 positions array, In position 0 there is the number and position 1

contains the type.
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Save
This class saves the network into a TXT file.
Attributes:

Network r
BufferedWriter output

Methods:

Save()

String getPathWithoutExtension(String s):
Returns the path without the extenion (.txt)

String saveFile(Network net,String nametxt,boolean saveAs):
This method opens the file the user has choosed and writes in it.

String seeCoreType(inti):
This method returns the type of the coreType according with that number.

String seeTopologyType(int i):

This method returns the type of the topologyType according with that number.
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Semaphore
This represents a semaphore (smm) element in the net.
Attributes:

String sw

double divFrec

int numBuUf

String args

final String preArgé
String posMem
boolean fixed
String CorePrefix
boolean bi

int inputBufDepth

Methods:

Semaphore(String i1, String i2, double d3, int i4,String a5,String 6, boolean b7,int
inputBufDepth )

Semaphore(String i1, String i2, double d3, int i4,String a5,String 16, boolean b7,boolean
bidir,int inputBufDepth)

setPosMem(String i)

String getPosMem()
setFixed(boolean b)
boolean getFixed()
setSwitch(String i)

String getSwitch()
setDivFrec(double i)

double getDivFrec|)
setNumBuUf(int i)

int getNumBuUf()
setArg5(String s)

String getArg5()
setincompleted(boolean b )
boolean getincompleted|)
boolean isBi)

setBi(boolean bi)

int getinputBufDepth()
setinputBufDepth(int inputBufDepth)
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SharedMemory
This represents a shared memory (shm) element in the net.
Attributes:

String sw

double divFrec

int numBuUf

String args

final String preArgé
String posMem
boolean fixed
String CorePrefix
boolean bi

int inputBufDepth

Methods:

SharedMemory(String i1, String 2, double d3, int i4,String a5,String 16, boolean b7,int
inputBufDepth )

SharedMemory (String i1, String i2, double d3, int i4,String a5,String i6, boolean b7,boolean
bidir,int inputBufDepth)

setPosMem(String i)

String getPosMem()
setFixed(boolean b)
boolean getFixed()
setSwitch(String i)

String getSwitch()
setDivFrec(double i)

double getDivFrec|)
setNumBuUf(int i)

int getNumBuUf()
setArg5(String s)

String getArg5()
setincompleted(boolean b )
boolean getincompleted|)
boolean isBi)

setBi(boolean bi)

int getinputBufDepth()
setinputBufDepth(int inputBufDepth)
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StatsWindow

This class shows the tables of the AMBA stats file.

Attributes:

JTable tablalnterl

JTable tablalnter2

JTable tablaProc1

JTable tablaProc?2

JTable tablaGen

Methods:

StatsWindow(Vector proc,Vector inl,Vector in2, String interl,Vector general)

double doubleValue(char(] a)

deseleccionar():
It puts all the radioButtons with selected =false.

drawGraph():
Show a graphic between the selected processors.

drawTables():
Depends on each jradioButtons some tables will be showed.

graphsResults(Vector selected, int longGrafico, int[] numProcSelected):
Create the graph with the amounts.

jRadioButtonGeneral_actionPerformed(ActionEvent e):

Deselect all jRadioButtons, then Selects this radioButton and draw the tables.

jJRadioButtoninterc_actionPerformed(ActionEvent e):
Deselect all jRadioButtons, then Selects this radioButton and draw the tables.

JRadioButtonProc_actionPerformed(ActionEvent e,int nump):
nump is the number of the processor. It deselects all jRadioButtons, then Selects this
radioButton and draw the tables.
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StatsWindow2
This class shows the tables of the Xpipes stafts file.
Attributes:

JTable tablalnterl
JTable tablalnter2
JTable tablaProc1
JTable tablaNI1
JTable tablalLR
JTable tablaBuf
JTable tablaOCP
Methods:

StatsWindow?2(Vector int1,Vector int2,Vector buffs, Vector LinkReceiv,Vector ocpT,String
ocplL,Vector Nltables,Vector proc)

double doubleValue(char[] a)

deseleccionar():
It puts all the radioButtons with selected =false.

drawGraph():
Show a graphic between the selected processors.

drawTables():
Depends on each jradioButtons some tables will be showed.

graphsResults(Vector selected, int longGrafico, int[] numProcSelected):
Create the graph with the amounts.

jRadioButtonBuffers_actionPerformed(ActionEvent e)
jRadioButtoninterc_actionPerformed(ActionEvent e)
jRadioButtonLR_actionPerformed(ActionEvent e)
JRadioButtonNI_actionPerformed(ActionEvent e,int numNI)
jRadioButtonOCP_actionPerformed(ActionEvent e)

JRadioButtonProc_actionPerformed(ActionEvent e,int nump)
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StatsWindowCompare
This class shows diferences between AMBA and Xpipes Stats.
Attributes:

JTable tablal
JTable tabla?2

Methods:
StatswindowCompare(Vector intX1,Vector intX2,Vector intAl,Vector intA2)
double doubleValue(char[] a)
deseleccionar():
It puts all the radioButtons with selected =false.
drawGraph():
Show a graphic between the selected processors.
drawTables():
Depends on each jradioButtons some tables will be showed.
graphsResults(Vector selected, int longGrafico, int[] numProcSelected):
Create the graph with the amounts.

jButtonGraphs_actionPerformed(ActionEvent e,int tipo)
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SunFloorMenu
This class lets to load or create the tables that SunFloor needs.
Attributes:

int numApli

JTable tabla2

JTable tabla3

JTabbedPane jTabbedPanel
Vector tablas]

int SumnFloorOK

Principal p

Methods:
SunFloorMenu(int format, Principal pr)

String getPathWithoutExtension(String
Returns the path without the extenion (.txt)

saveFiles():
Save the three tables into XML files

saveXML(int type)

desactiveAll():
Deselcts all the radioButtons

dibuja():
draw the correspondent table or buttons in each step.

jButtonAccept_actionAdapter(ActionEvent e)
jButtonBack_actionPerformed(ActionEvent e)
jButtonCancel_actionPerformed(ActionEvent e)
jButtonChangeDefault_actionAdapter(ActionEvent e)
jButtonDelete Apli_actionPerformed(ActionEvent )
jButtonDeleteFila_actionPerformed(ActionEvent e)
jButtonNewApli_actionPerformed(ActionEvent e)
jButtonNewfFila_actionPerformed(ActionEvent e)
jButtonNext_actionPerformed(ActionEvent )
jButtonSaveAs_actionAdapter(ActionEvent e)
jFileChooser1_actionPerformed(ActionEvent e)
JRadioButtonDefault_actionPerformed(ActionEvent e)
JRadioButtonNew_actionPerformed(ActionEvent e)
JRadioButtonOpen_actionPerformed(ActionEvent e)
muestraAbrirNuevo(boolean b)
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SWARM_processor

This class contains all the Information about a processor in the statswindow.

Attributes:

Vector processorTable2
String processorAccesesLabel
Vector processorTablel

String processorinfoLabel
String processorinfoLabel2
String processorinfoLabel3
String processorinfoLabel4
String processorinfoLabel5
Vector infoCache

Methods:

SWARM_processor(Vector v1, String s2, Vector v3, String s4, String s5, String sé, String s7,
String s8, Vector v9)
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SwinforWindow
This class shows the attributes of a switch.
Attributes:

Principal p
Network r

Methods:
SwinforWindow (String nom,Principal p)
Vector giveMeRoutes(int n):

Returns a Vector of routes in which the core appears.
JComponent makeTextPanel(String text)
acceptButton_actionPerformed(ActionEvent e):

Close the window.
deleteButton_actionPerformed(ActionEvent e):

Close the window and show a new window to delete the switch => menu=new
SwMenu(2,number,p,this)

modifyButton_actionPerformed(ActionEvent e):

Close the window and show a new window to modify the switch => menu=new
SwMenu(1,number,p,this);

String[] readOnlySwitchName (String n):

Retuns the switch name , and the subchannel in the second position.
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Switches
This class represents another element of the network, the switch.
Attributes:

int inputs

int outputs

int numBuf

int coorX

int coorY

int inputsUsedConnections
int outputsUsedConnections
boolean XYconections

int inputBufDepth

Vector subChannels

Methods:

Switches(String i1, int i2, int i3, int i4,int i5)
Switches(String i1, int i2, int i3, int i4,int i5,Vector subcha)

Switches(String i1, inti2, int i3, int i4, int i5, int i6,int i7):
Switches(String i1, int i2, int i3, int 4, int i5, int i6,int i7,Vector subcha):

for topologyType= mesh or torus.

int getCoorX()

setCoorX(int i)

int getCoorY()

setCoorY(int i)

int getinputBufDepth()
setinputBufDepth(int inputBufDepth)
int getinputs()

setlinputs(int i)

int getinputsUsedConnections()
setOutputsUsedConnections(int i)
int getNumBuUf|()

setNumBuUf(int i)

int getOutputs()

setOutputs(int i)

int getOutputsUsedConnections|)
setOutputsUsedConnections(int i)
Vector getSubChannels|)
setSubChannels(Vector subChannels)

boolean hasSubchannel(String a)
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SwMenu
This class shows a window to create modify or delete a switch.
Attributes:

Principal p
Network r

Methods:
SwMenu(int n, int directa,Principal p)
boolean estaChannels(String s) :

Returns true if the subchannel already exist in the switch.
CancelButton_actionPerformed(ActionEvent e):

Close the window.
acceptButton_actionPerformed(ActionEvent e):

Make sure all the attributes are correct and modify or delete the new element.
int value(charl] a):

Returns the int value of a char array of digits.
properties():

Show the properties of the element selected.

String[] readOnlySwitchName (String n)
update2()

updateSubcha_actionPerformed(ActionEvent e)
boolean esta(String n):

Returns the switch name , and the subchannel in the second position.
addButton_actionPerformed(ActionEvent e)

deleteButton_actionPerformed(ActionEvent )
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Tree

This class represents the Tree of the network.
Attributes:

Vector facts[]

Principal p

Network net

DefaultMutableTreeNode root
DefaultMutableTreeNode branch, selection
JTree free

DefaultTreeModel model

Methods:

Tree(Principal p)

updateTree(Network n):

Build the tree from the network.

TreeSunFloor
This class represents the Tree of Sunfloor.
Attributes:
Principal p
String facts(]
DefaultMutableTreeNode root
DefaultMutableTreeNode app, tecno, ip , selection
JTree free
DefaultTreeModel model
Methods:
TreeSunfloor(Principal p)

public void updateTree():

Build the tree from the network.
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4. EXTERN TOOLS

NoCdificador is an application that creates, modifies and control the correctness of a
network, but it can’t compile, simulate or create topologies automatically. To do all this
tasks, it uses some external applications such as SunFloor, xPipesCompiler or MPARM.

4.1 SunFloor

SunFloor is a custom CAD tool used to synthesize the most power/performance efficient
NoC ftopology that safisfies the application requirements. The application traffic
characteristics, size of the cores, and the area and power models for the network
components are obtained as inputs to the synthesis engine. The tool generates different
NoC switches and maps the cores onto the switches. During the synthesis process, it
determines deadlock-free routes for the different traffic flows of the application. The tool
also produces the 2D floorplan of the synthesized NoC topology. This floorplan is
generated on gnuplot format, so gnuplot is used to convert the floorplan generated by
SunFloor to png, in order to be shown by NoCdificador. The output produced by the tool is
a text file that defines the synthesized topology, which is fed to the next phase of the flow.
In our case, it is fed to NoCdificador, in order to be checked or even modified before
being compiled.

SunFloor is a fully automated solution that optimizes architectural parameters of the NoC
tuning based upon applications requirements. It can generate both regular and custom-
designed topologies, and choose it in an automatic way. Usually the type of topology is
one of the most problematic decision in a hand-mapped design.

Designs generated by SunFloor are much more optimized than hand-mapped design for
the same frequency. SunFloor design uses less switches and reduces the power
consumption, although sometimes has a little increase of the area. But, maybe, the most
important fact is that a design made with SunFloor can be ready in a few hours. A hand-
mapped design could cost several weeks working on it.

4.2 XpipesCompiler

XpipesCompiler is another custom tool. It reads a topology definition file, generated by
SunFloor, hand-mapped or created with NoCdificador, and instantiates the RTL
description of the NoC components using Xpipes, a pre-designed SystemC RTL
component library. The modules in the component library support a large number of
instantiation parameters, such as different input/output ports, buffer sizes, etc. The tool also
inferconnects the RTL description of the processor/memory cores of the SoC (which are
predesigned components, taken as user inputs) with the RTL code of the network
components. The output of this step is the RTL design of the entire NoC that can be
simulated and synthesized.
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4.3 MPARM

MPARM is a multi-processor cycle-accurate architectural simulator. Its purpose is the
system-level analysis of design fradeoffs in the usage of different processors, interconnects,
memory hierarchies and other devices.

MPARM simulates different processor models, but in our case is SWARM the most
important. SWARM (SoftWare ARM) is a modular simulation of an ARM 7 processor.

It also has different inferconnection models. In our case, we use xpipes NoC to simulate

the topology who has just been designed, but we also use AMBA model in order to
compare NoC interconnection results with bus interconnection results.
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5. CONCLUSION

As our project was aimed on the development of an application to configure NoCs, we
have not been able to reach a great number of conclusions. Anyway, we could
enumerate some of them, which can be divided in two groups: conclusions we reached
during the development and conclusions we reached while using the application.

5.1 Development conclusions

Maybe the main conclusion we could remark is the design and implementation the
application.

But this develop have made us learn much other things. For example, we have discover
the world of NoC. We have learnt what a NoC is, how does them work and why they are
necessary.

Another important thing we could detail is that we have got familiar with the investigation
environment, that was completely unknown for us until we began this project.

Finally, we'd like to express how difficult was sometimes to develop an application that
depends on other applications, when both are being developed at the same time. We
have never worked like this before, and we have realized coordination is very important to
avoid useless efforts.

5.2 User conclusions

Beside being developers, we have also been users of NoCdificador. As users, we have
been able to conclude some remarkable facts about differences compiling SoC’s with
Xpipes (using NoC for the interconnection) and AMBA (using buses).

Using Xpipes provides better performance under congestion, and much better scalability.
On the other hand, AMBA still gives a lower power consumption, and much better area
integration.

To sum up, we could say that NoC's technology is growing up very fast, but still have to
improve some aspects such as power consumption an integration.
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